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chapitre 1

 

Bienvenue dans le système Mbox

 

Bienvenue dans le système Mbox, le micro 
studio portable de Digidesign fonctionnant en 
tandem avec Pro Tools et conçu en 
collaboration avec Focusrite.

Mbox fournit à votre ordinateur équipé d’un 
port USB deux canaux d’entrée et de sortie 
analogiques et numériques, dotés de deux 
préamplis micro de qualité professionnelle et de 
convertisseurs analogique/numérique et vice-
versa. 

Le coffret Mbox contient les éléments suivants :

• L’interface audio Mbox de bureau

• Le CD d’installation contenant le logiciel 
Pro Tools LE, les plug-in DigiRack RTAS 
(Real-Time AudioSuite) et AudioSuite, le 
logiciel DigiStudio et les guides en ligne au 
format PDF

• Le guide 

 

Introduction à Mbox

 

, qui inclut des 
instructions d’installation et de configuration 
du système Mbox, ainsi qu’une introduction 
au logiciel Pro Tools LE

• Le câble du connecteur USB

• Une carte d’enregistrement Digidesign

 

Fonctions du système Mbox

 

L’interface audio de bureau du système Mbox 
fournit les fonctions suivantes :

• 2 entrées audio analogiques dotées de 
préamplis micro Focusrite et d’une 
alimentation fantôme 48 V commutable

• Des jacks d’entrée analogique acceptant les 
connecteurs XLR et 1/4 de pouce (TRS) et sont 
commutables entre le micro, la ligne et les 
niveaux des instruments

• 2 canaux d’entrée et de sortie 
numériques S/PDIF

• 2 sorties analogiques d’écoute

• Des convertisseurs N/A et A/N 24 bits 
acceptant des fréquences d’échantillonnage 
de 44,1 kHz et 48 kHz

• Un contrôle d’enregistrement analogique à 
latence zéro avec équilibrage réglable entre 
l’entrée et la lecture

• Une touche mono pour la sommation du 
signal d’entrée avec le mixage d’écoute

• Un insert analogique TRS de 1/4 de pouce sur 
chaque entrée

• Une sortie casque stéréo de 1/4 de pouce 

 

(

 

TRS

 

) 

 

ou de 1/8 de pouce avec commande des 
niveaux réglable

• Alimentation par USB



 

Introduction à Mbox

 

2

 

Fonctions de Pro Tools LE

 

Lorsqu’il est associé à Mbox, le logiciel 
Pro Tools LE comporte les fonctions suivantes :

• Les systèmes Pro Tools LE 6.0 et 
Pro Tools LE 5.3.3 peuvent lire 
simultanément jusqu’à 32 pistes audio 
numériques mono et jusqu’à 30 pistes lors de 
l’enregistrement de 2 pistes maximum, selon 
la puissance de votre ordinateur.

• Pro Tools LE 5.2.1 peut lire simultanément 
jusqu’à 24 pistes audio numériques mono et 
jusqu’à 22 pistes lors de l’enregistrement de 
2 pistes maximum, selon la puissance de votre 
ordinateur. Visitez le site Web Digidesign pour 
obtenir des informations sur les fonctions de 
lecture de 32 pistes avec Pro Tools LE 5.2.1. 

• Fonctionne avec une résolution audio 16 ou 
24 bits, à des fréquences d’échantillonnage 
allant jusqu’à 48 kHz.

• Enregistrement et lecture jusqu’à 128 pistes 
MIDI (interface MIDI non fournie).

• Edition à accès aléatoire et non linéaire, et 
automation de mixage.

• Traitement audio avec jusqu’à 5 plug-in RTAS 
par piste, selon la puissance de votre 
ordinateur.

• Jusqu’à 5 inserts et 5 envois par piste.

• Jusqu’à 16 bus de mixage internes.

 

A propos de DigiStudio

 

(Pro Tools LE 5.2.1 uniquement)

 

Pro Tools LE permet d’accéder à DigiStudio™, 
le studio d’enregistrement virtuel de Digidesign, 
permettant ainsi aux utilisateurs de Pro Tools de 
collaborer sur Internet avec d’autres utilisateurs 
de Pro Tools, se trouvant dans des locaux 
différents et même dans des pays différents. 

Pour utiliser DigiStudio, installez d’abord Mbox 
et Pro Tools LE, en suivant les instructions 
fournis dans ce guide, puis reportez-vous au 

 

Guide DigiStudio

 

 pour obtenir des détails sur la 
configuration de votre système pour DigiStudio.

 

Configuration requise

 

Mbox peut être utilisé sur un PC Windows ou un 
ordinateur Macintosh approuvé par Digidesign 
et exécutant le logiciel Pro Tools LE. 

Digidesign ne peut garantir la compatibilité et 
fournir une assistance que pour le matériel et les 
logiciels testés et agréés par ses soins. Pour 
connaître la liste des ordinateurs, systèmes 
d’exploitation, disques durs et périphériques 
tiers approuvés par Digidesign, reportez-vous 
aux informations de compatibilité sur le site 
Web de Digidesign 
(www.digidesign.com/compato). 

 

Mbox ne fonctionnera pas correctement s’il 
est connecté à un hub USB. Si vous souhaitez 
utiliser un hub pour d’autres périphériques 
USB, utilisez un port USB distinct ; 
le système Mbox nécessite un port dédié pour 
fonctionner correctement.

 

Pro Tools LE utilise le processeur de votre 
ordinateur pour mixer et traiter les pistes 
audio (traitement hôte). Les ordinateurs 
fonctionnant à des vitesses d’horloge plus 
rapides peuvent produire un plus grand 
nombre de pistes et assurer le traitement par 
plug-in.
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Espace de stockage du disque dur

 

Les pistes audio mono enregistrées en résolution 
16 bits à 44,1 kHz (qualité CD) nécessitent 
environ 5 Mo d’espace disque par minute. 

Les mêmes pistes enregistrées en résolution 
24 bits nécessitent environ 7,5 Mo par minute. 
Le Tableau 1 indique la quantité d’espace disque 
nécessaire en fonction du nombre de pistes et de 
leur longueur, vous permettant ainsi d’évaluer le 
taux d’utilisation de votre disque dur.

 

Enregistrement déconseillé sur les 
lecteurs système

 

Bien qu’il soit possible d’enregistrer sur votre 
lecteur système dans Pro Tools, ceci est 
généralement déconseillé. Les performances 
d’enregistrement et de lecture sur les lecteurs 
système sont amoindries, avec pour résultat un 
nombre inférieur de pistes et de plug-in. 

 

L’enregistrement sur lecteurs système n’est 
pas recommandé par Digidesign. Ne le 
faites que si cela s’avère vraiment 
nécessaire. 

 

Tableau 1. Espace disque requis pour les pistes audio

 

Nombre de pistes et durée 16 bits à 
44,1 kHz

16 bits à 
48 kHz

24 bits à 
44,1 kHz

24 bits à 
48 kHz

 

1 piste mono, 1 minute 5 Mo 5,5 Mo 7,5 Mo 8,2 Mo

1 piste stéréo (ou deux pistes 
mono), 5 minutes

50 Mo 55 Mo 75 Mo 83 Mo

1 piste stéréo (ou deux pistes 
mono), 60 minutes

600 Mo 662 Mo 900 Mo 991 Mo

24 pistes mono, 5 minutes 600 Mo 662 Mo 900 Mo 991 Mo

24 pistes mono, 60 minutes 7 Go 7,8 Go 10,5 Go 11,6 Go

32 pistes mono, 5 minutes 800 Mo 883 Mo 1,2 Go 1,3 Go

32 pistes mono, 60 minutes 9,4 Go 10,4 Go 14 Go 15,4 Go
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Enregistrement auprès de 
Digidesign

 

N’oubliez pas de remplir et de retourner la carte 
d’enregistrement fournie avec le système 
Pro Tools Mbox. Les utilisateurs inscrits 
reçoivent régulièrement des mises à jours 
logicielles et sont avertis des mises à niveau. 
Reportez-vous au formulaire d’enregistrement 
pour en savoir plus sur les services fournis par 
l’assistance technique.

 

A propos des guides Pro Tools

 

Ce guide 

 

Introduction à Mbox

 

 explique comment 
installer et utiliser Mbox pour enregistrer, editer 
et mixer des pistes audio et MIDI dans 
Pro Tools LE. Vous trouverez d’autres 
informations en consultant les guides en ligne 
suivants :

• Le 

 

Guide de référence Pro Tools 

 

offre une 
présentation détaillée du logiciel Pro Tools LE. 

• Le 

 

Guide DigiStudio

 

 (Pro Tools 5.2.1 
uniquement) présente la configuration et 
l’utilisation du studio virtuel en ligne de 
DigiStudio. 

• Le 

 

Guide des plug-in DigiRack

 

 explique 
comment utiliser les plug-in RTAS et 
AudioSuite inclus dans Pro Tools LE. 

• Le 

 

Guide des surfaces de contrôle MIDI

 

 explique 
comment utiliser les surfaces de contrôle 
MIDI (telles que la MotorMix de CM Labs) 
avec Pro Tools LE. 

• La section 

 

Raccourcis clavier

 

 fournit la liste des 
raccourcis clavier pour Pro Tools LE. 

Les versions PDF des guides Pro Tools sont 
installées automatiquement avec Pro Tools LE 
et peuvent être facilement consultées depuis le 
menu Pro Tools (Mac OS X) ou depuis le menu 
Help de Pro Tools (Windows XP et Mac OS 9). 
Pour lire ces guides en ligne ou les imprimer, 
vous devez installer Acrobat Reader (fourni sur 
le CD d’installation de Pro Tools LE).

 

Conventions utilisées dans ce  
guide

 

Les guides de Digidesign utilisent les 
conventions suivantes pour indiquer les 
commandes de menus et les touches de 
raccourci :

 

Des copies imprimées de l’ensemble de 
manuels de Pro Tools LE (y compris le 
Guide de référence Pro Tools) peuvent être 
achetées séparément depuis DigiStore 
(www.digidesign.com).

 

Convention Action

 

File > Save 
Session

Sélectionnez Save Session dans 
le menu File.

Ctrl + N Maintenez la touche Ctrl enfoncée 
tout en appuyant sur la touche N.

Option + clic Cliquez à l’aide du bouton de la 
souris, tout en maintenant la 
touche d’option enfoncée.
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Les symboles qui suivent permettent de mettre 
en évidence des informations importantes :

 

.

 

Les conseils aux utilisateurs sont des 
astuces permettant d’optimiser l’utilisation 
du système.

Les avertissements importants contiennent 
des informations susceptibles de modifier 
les données ou les performances du système.

Ces raccourcis vous indiquent les 
commandes utiles au clavier et à la souris.

Les renvois dirigent l’utilisateur vers les 
sections correspondantes des autres guides 
de Digidesign.
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chapitre 2

 

Configuration Windows

 

L’installation de Mbox sur un PC Windows 
comprend les étapes suivantes :

 

1  

 

Configuration des paramètres du logiciel 
système Windows (reportez-vous à la section 
« Paramètres système Windows », page 7).

 

2  

 

Connexion de l’unité Mbox à votre ordinateur 
et installation du logiciel Pro Tools LE (reportez-
vous à la section « Installation de Mbox et 
Pro Tools LE », page 11).

 

3  

 

Redémarrage de l’ordinateur.

 

4  

 

Configuration du système Pro Tools (reportez-
vous à la section « Configuration de 
Pro Tools LE », page 15).

 

5  

 

Etablissement de connexions audio avec le 
systèmeMbox (reportez-vous au Chapitre 4, 
« Connexion du studio »).

 

Paramètres système 
Windows

 

Cette section indique les paramètres système 
Windows XP requis et recommandés. 

 

Paramètres requis : 

 

veuillez suivre ces 
instructions avant d’installer Pro Tools. 

 

Paramètres recommandés : 

 

veuillez suivre ces 
instructions afin d’optimiser les performances 
de votre système ou de permettre à des 
ordinateurs plus anciens d’exécuter 
Pro Tools LE.

 

Dépannage et paramètres avancés : 

 

veuillez 
suivre ces instructions si les problèmes 
persistent après la configuration de tous les 
paramètres requis et recommandés. Pour plus 
d’informations, reportez-vous à l’Annexe A, 
« Optimisation du système Windows ». 

 

Paramètres requis

 

Pour optimiser les performances avec 
Pro Tools LE, vous devez configurer certains 
paramètres du Panneau de configuration de 
votre version Windows XP.
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Activation DMA

 

L’activation DMA (Direct Memory Access) de 
votre ordinateur libère de l’espace sur la bande 
passante CPU, permettant ainsi à votre 
ordinateur d’effectuer d’autres tâches Pro Tools.

Dans la plupart des cas, l’option DMA est déjà 
définie correctement car Windows XP détecte et 
active le mode DMA par défaut.

Activez DMA pour les contrôleurs IDE de 
disques durs :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Gérer. Si vous 
êtes en mode Affichage classique, sélectionnez 
Démarrez > Panneau de configuration > Système 
> Matériel. Si vous êtes en mode Affichage des 
catégories, choisissez Démarrez > Panneau de 
configuration > Performances et maintenance > 
Système > Matériel. 

2  Dans Outils système, sélectionnez 
Gestionnaire de périphériques.

3  Dans la fenêtre du Gestionnaire de 
périphériques, cliquez deux fois sur Contrôleurs 
ATA/ATAPI IDE, puis cliquez deux fois sur Canal 
IDE principal pour votre disque dur IDE.

4  Cliquez sur l’onglet Paramètres avancés.

5  Pour chaque disque, définissez le mode de 
transfert à « DMA si disponible », puis cliquez 
sur OK.

Dans la plupart des cas, cette option est déjà 
définie correctement car Windows XP détecte et 
active le mode DMA par défaut.

6  Répétez les étapes 3 et 4 pour tout canal IDE 
supplémentaire.

7  Fermez la fenêtre Gestion de l’ordinateur.

Désactivation du logiciel de protection 
anti-virus

Evitez d’exécuter des logiciels anti-virus lorsque 
vous utilisez Mbox, car ils peuvent avoir une 
incidence sur les performances du système 
(comme tout processus d’arrière-plan). Si vous 
utilisez un logiciel anti-virus, vous devez le 
désactiver ou le supprimer, puis redémarrer 
votre ordinateur. 

Désactivation de la mise en veille et de 
la gestion de l’alimentation

Si vous utilisez Pro Tools, le mode de mise en 
veille du système Windows doit être défini sur 
Toujours actif. Ceci réduit le risque qu’une 
longue session d’enregistrement ou de lecture 
s’arrête inopinément à cause de la mise hors 
tension des ressources système. Cela évite 
également les pertes de connexion USB par le 
système Mbox lorsque le système s’arrête 
pendant une longue période de temps. 

Pour configurer la gestion de l’alimentation de 
Windows :

1  Choisissez Démarrer > Paramètres > Panneau 
de configuration.

2  En mode Affichage classique, cliquez deux fois 
sur l’icône Options d’alimentation, puis cliquez 
sur l’onglet Modes de gestion de l’alimentation 

– ou –

En mode Affichage des catégories, cliquez sur 
Performances et maintenance, puis sur Gestion 
de l’alimentation et enfin sur l’onglet Modes de 
gestion de l’alimentation.

3  Dans le menu contextuel Modes de gestion de 
l’alimentation, sélectionnez Toujours actif.
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4  Cliquez sur OK. 

Ceci définit les options de mise en veille, de 
mise en veille prolongée et d’arrêt des disques 
durs sur Jamais.

Paramètres matériels et logiciels 
recommandés

Les paramètres suivants sont recommandés 
pour optimiser les performances de votre 
système et pour rendre votre système 
compatible, en réduisant les risques de conflits 
matériels ou logiciels. 

Définition des options d’affichage

Ces paramètres permettent d’améliorer 
l’affichage des polices et le dessin des graphiques 
dans Pro Tools.

Pour définir les options d’affichage :

1  Choisissez Démarrer > Paramètres > Panneau 
de configuration. 

2  En mode Affichage classique, cliquez deux fois 
sur Affichage 

– ou –

En mode Affichage des catégories, cliquez sur 
Apparence, Thèmes, puis sur Affichage.

3  Cliquez sur l’onglet Affichage.

4  Cliquez sur Effets.

5  Sélectionnez l’option Utiliser la méthode 
suivante pour lisser les bords des polices écran.

6  Sélectionnez l’option Clear Type dans le menu 
contextuel.

7  Décochez la case Afficher le contenu des 
fenêtres pendant leur déplacement.

8  Cliquez sur OK pour enregistrer vos 
paramètres et fermer la boîte de dialogue Effets.

9  Cliquez sur OK.

Pro Tools LE peut également être affecté par 
d’autres pilotes logiciels ou matériels installés 
sur votre ordinateur. Pour optimiser les 
performances, suivez les recommandations 
ci-dessous :

• Evitez d’exécuter d’autres programmes 
Windows en même temps que 
Pro Tools LE.

• Désactivez les logiciels qui fonctionnent en 
arrière-plan, tels que Windows Messenger, 
les calendriers et les programmes de 
maintenance de disque. 

• Lorsque vous utilisez Mbox, éteignez tous 
les périphériques USB n’étant pas 
indispensables.

• Si votre carte vidéo le permet, activez le 
contrôle de bus (Bus Mastering) dans le 
Panneau de configuration du fabricant.
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Configuration et maintenance 
du disque dur

Formatage d’un lecteur audio

Sous Windows, il est recommandé de démarrer 
avec un lecteur venant d’être formaté dédié pour 
l’audio. Pour obtenir des performances 
optimales, les lecteurs audio doivent être 
formatés avec le système de fichiers FAT32 
ou NTFS. 

Pour formater et configurer un lecteur audio :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Gérer. 

2  Sous Stockage, sélectionnez Gestion des 
disques.

3  Dans la fenêtre Gestion des disques, cliquez 
avec le bouton droit de la souris sur le disque dur 
que vous utiliserez pour l’audio et choisissez 
Formater.

4  Pour optimiser les performances du disque 
optique, sélectionnez 32K dans le menu 
contextuel Taille d’unité d’allocation. Ceci 
permet d’améliorer l’écriture et la lecture de 
données sur et depuis le lecteur. 

5  Assurez-vous que l’option Quick Format est 
désélectionnée, puis cliquez sur Démarrer et 
suivez les instructions à l’écran.

6  Lorsque le formatage est terminé, fermez la 
fenêtre. 

Lecteurs audio et nettoyage du disque

L’enregistrement, l’édition et la suppression de 
pistes et de sessions peuvent rapidement ralentir 
les performances générales du disque. Nous 
vous conseillons d’utiliser régulièrement la 
fonction Nettoyage de disque (ou tout utilitaire 
équivalent) pour évaluer l’état des lecteurs et, si 
cela est nécessaire, pour supprimer des fichiers 
temporaires et autres données inutiles. 

Pour utiliser le Nettoyage de disque : 

1  Choisissez Démarrer > Paramètres > Panneau 
de configuration. 

2  En mode Affichage classique, cliquez deux fois 
sur Outils d’administration 

– ou –

En mode Affichage des catégories, cliquez sur 
Performances and Maintenance, puis cliquez sur 
Outils d’administration. 

3  Sélectionnez Gestion de l’ordinateur, puis 
Stockage. 

4  Choisissez Gestion des disques. 

5  Sélectionnez un volume dans la liste, puis 
choisissez Fichier > Options. 

Le Nettoyage de disque détermine la façon dont 
l’état du lecteur altère les performances et vous 
permet de supprimer des fichiers temporaires ou 
inutiles du volume sélectionné. Pour plus 
d’informations sur l’utilisation du Nettoyage de 
disque, consultez votre documentation 
Windows XP. 

Défragmentation d’un lecteur audio

Pensez à défragmenter fréquemment les lecteurs 
audio afin de stabiliser les performances du 
système. 

Pro Tools prend uniquement en charge les 
lecteurs de base.
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Pour défragmenter un lecteur audio :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Gérer.

2  Sous Stockage, sélectionnez Défragmenteur de 
disque.

3  Dans la fenêtre Défragmenteur de disque, 
sélectionnez le lecteur que vous souhaitez 
défragmenter.

4  Cliquez sur Défragmenter et suivez les 
instructions à l’écran.

5  Lorsque la défragmentation est terminée, 
refermez la fenêtre Gestion de l’ordinateur.

Enregistrement déconseillé sur les 
lecteurs système

Bien qu’il soit possible d’enregistrer sur votre 
lecteur dans Pro Tools, ceci est généralement 
déconseillé. Les performances d’enregistrement 
et de lecture sur les lecteurs système sont 
amoindries, ce qui se traduit par un nombre 
inférieur de pistes et de plug-in. Vous ne devez 
enregistrer sur des lecteurs système qu’en cas de 
nécessité : par exemple, si votre ordinateur ne 
comporte qu’un seul disque dur.

Installation de Mbox et 
Pro Tools LE

Pour installer Pro Tools LE sous Windows : 

1  Démarrez Windows en vous connectant en 
tant qu’administrateur. Si vous ne disposez pas 
de privilèges d’administrateur ou que vous ne 
savez pas comment les configurer, reportez-vous 
au Guide de l’utilisateur Windows.

2  Raccordez l’extrémité la plus fine du câble USB 
fourni au port USB port du Mbox.

3  Connectez l’autre extrémité du câble USB à 
tout port USB disponible sur votre ordinateur. 
Lorsque la boîte de dialogue Assistant Matériel 
détecté s’affiche, laissez-la ouverte. N’appuyez 
pas sur Suivant.

4  Insérez le CD d’installation de Pro Tools pour 
Windows dans le lecteur de CD-ROM. Dans le 
dossier d’installation de Pro Tools, recherchez 
l’icône bleue Setup, puis cliquez deux fois 
dessus.

5  Lorsque le programme d’installation s’ouvre, 
cliquez sur Suivant pour continuer.

6  Choisissez l’une des trois options 
d’installation proposées :

• Standard, recommandée pour les 
utilisateurs débutants

• Compacte, pour installer uniquement les 
composants nécessaires à l’exécution de 
Pro Tools LE

• Personnalisée, pour sélectionner les 
composants à installer (destinée aux 
utilisateurs expérimentés)

7  Cliquez sur Suivant pour installer l’option 
sélectionnée. Les fichiers sont installés dans le 
dossier Digidesign du répertoire Program Files.

8  Attendez que le programme ait installé tous 
les composants, pilotes et systèmes de fichiers 
PACE pour passer à l’étape suivante. 

Mbox ne fonctionne pas correctement si 
vous le connectez à un hub USB. Si vous 
souhaitez utiliser un hub pour d’autres 
périphériques USB, connectez-le à un autre 
port USB ; le système Mbox requiert un port 
dédié pour fonctionner correctement.

Si un message d’avertissement vous indique 
que l’essai du logo Windows a échoué, 
cliquez sur Continuer.
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9  Cliquez sur Quit lorsque vous être invité à 
installer QuickTime. Vous l’installerez plus tard. 

10  Redémarrez l’ordinateur. 

11  Lancez Pro Tools LE. 

12  Localisez le programme d’installation de 
QuickTime sur le CD d’installation Pro Tools LE 
(situé dans le dossier Additional Files). Suivez les 
instructions à l’écran pour terminer 
l’installation de QuickTime. 

13  Une fois l’installation terminée, cliquez sur 
Finish pour redémarrer l’ordinateur.

Installation de QuickTime
(facultatif)

Procédez à l’installation de QuickTime 5 ou 
ultérieure si vous prévoyez d’inclure des fichiers 
film dans vos sessions Pro Tools LE. 
L’installation de la dernière version de 
QuickTime pour Windows est vivement 
conseillée. Vous la trouverez sur le site Web 
disponible www.apple.com. Veillez à procéder à 
l’installation Recommandée de QuickTime. 
Dans le cas contraire, Pro Tools ne prend pas en 
charge correctement les vidéos QuickTime.

Mise à jour du microprogramme 
de Mbox

L’utilisation de Mbox sous Windows XP requiert 
l’installation de la version 2.0 ou ultérieure du 
microprogramme.

Pour mettre à jour le microprogramme sur Mbox :

1  Vérifiez que Pro Tools est installé et que Mbox 
est relié à votre ordinateur.

2  Cliquez deux fois sur le fichier 
MboxirmwareUpdater.exe situé sur C:\Program 
Files\Digidesign\Pro Tools\Pro Tools Utilities.

3  Pour vérifier la version du microprogramme 
installée sur le système Mbox, cliquez sur le 
bouton Start dans la fenêtre Mbox Firmware 
Update.

4  Pour mettre à jour la version du 
microprogramme sur le système Mbox, cliquez 
sur le bouton Start dans la fenêtre Mbox 
Firmware Update.

5  Cliquez sur Start pour vérifier la version du 
microprogramme installée sur le système Mbox 
et lancer la mise à niveau du microprogramme. 

Si le voyant USB situé sur le panneau avant 
du système Mbox relié à votre ordinateur ne 
s’allume pas après l’installation, 
débranchez le câble USB depuis le port USB 
de Mbox, puis rebranchez-le. Si le voyant ne 
s’allume toujours pas, éteignez votre 
ordinateur, débranchez le système Mbox 
puis redémarrez votre ordinateur. Après 
avoir redémarré votre ordinateur, connectez 
de nouveau le système Mbox.

Si votre ordinateur ne démarre pas après 
l’installation de QuickTime, utilisez 
Ajout/Suppression de programmes pour 
supprimer Pro Tools LE et QuickTime, puis 
répétez la procédure d’installation décrite 
dans la section « Installation de Mbox et 
Pro Tools LE », page 11.

Avant de procéder à la mise à jour du 
microprogramme de Mbox, vous devez 
installer le logiciel Pro Tools LE et 
connecter le système Mbox à votre 
ordinateur.
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6  Suivez les instructions à l’écran :

• Déconnectez Mbox du port USB de votre 
ordinateur.

• Connectez à nouveau Mbox au port USB de 
votre ordinateur. Le nouveau 
microprogramme est envoyé vers Mbox.

• Déconnectez et connectez de nouveau 
Mbox.

7  Cliquez sur OK.

Pilote ASIO Digidesign
(facultatif)

Le pilote ASIO (Audio Sound Input Output) 
Digidesign est un pilote audio multimédia 
multicanal qui permet à des applications audio 
tiers d’enregistrer et de lire des données audio 
via les canaux 1 et 2 de Mbox. Le pilote ASIO 
Digidesign n’est pas requis pour utiliser 
Pro Tools LE avec Mbox. 

Installation de la session de 
démonstration
(facultatif)

Le CD d’installation de Pro Tools LE comprend 
une session de démonstration vous permettant 
de vérifier le bon fonctionnement du système.

Pour installer les sessions de démonstration :

1  Insérez le CD d’installation de Pro Tools LE 
dans le lecteur de CD-ROM. Localisez le fichier 
Setup.exe et cliquez deux fois dessus. Il se trouve 
sur le lecteur D:\Additional Files\Pro Tools LE 
Demo Session Installer. 

2  Définissez l’emplacement d’installation sur 
votre lecteur audio et cliquez sur Install.

3  Une fois l’installation terminée, cliquez 
sur OK.

Installation de MacOpener
(facultatif)

MacOpener permet d’enregistrer et de lire de 
l’audio depuis des disques durs formatés NTFS 
ou FAT32 sur des systèmes Pro Tools sous 
Windows. 

N’installez pas le pilote ASIO si vous 
utilisez WaveDriver de Digidesign. 
Visitez le site Web Digidesign 
(www.digidesign.com) pour découvrir les 
tous derniers pilotes du matériel 
Pro Tools LE et pour en savoir plus sur les 
problèmes connus.

Pour plus d’informations sur l’installation, 
l’utilisation et la suppression du pilote 
ASIO Digidesign, reportez-vous au fichier 
Readme du pilote ASIO Digidesign.

Avant d’installer la session de 
démonstration sur votre lecteur audio, 
vérifiez que ce dernier est configuré comme 
indiqué dans la section « Configuration et 
maintenance du disque dur », page 10.

L’utilisation de MacOpener est déconseillée 
sur des disques durs HFS et il est conseillé 
d’utiliser un disque dur formaté NTFS ou 
FAT32 pour procéder à cette opération. 
Utilisez la commande Save Session Copy In 
dans Pro Tools pour copier le matériel de la 
session sur un lecteur audio Windows 
formaté à l’aide du système NTFS ou 
FAT32. 
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MacOpener permet également d’ouvrir des 
sessions Pro Tools créées sur un ordinateur 
Macintosh. Pour partager des sessions Pro Tools 
entre un système Macintosh et un système 
Windows, sélectionnez l’option Enforce 
Mac/PC Compatibility lorsque vous créez une 
session ou que vous en enregistrez une copie. 

Pour installer et configurer la démo MacOpener 
fournie avec Pro Tools :

1  Insérez le CD d’installation Pro Tools dans le 
lecteur de CD-ROM. 

2  Localisez le fichier d’installation de 
MacOpener et cliquez deux fois dessus. Il se 
trouve dans le dossier MacOpener Demo sur le 
lecteur D:\Additional Files\MacOpener Demo 
Installer. Pour procéder à l’installation de 
MacOpener, suivez les instructions affichées à 
l’écran. Une fois l’installation terminée, 
redémarrez l’ordinateur.

3  Sélectionnez Démarrer > Programmes > 
MacOpener > MacOpener Driver Preferences.

4  Vérifiez que le pilote MacOpener est actif. 
Dans Driver Settings, sélectionnez l’option 
Enable MacOpener Driver.

5  Dans Extension Mapping, sélectionnez 
l’option Do not add the PC extension to the 
Mac file name.

6  Cliquez sur OK pour quitter MacOpener 
Driver Preferences. 

7  Choisissez Démarrer > Programmes > 
MacOpener > Mac Lic.exe. Lorsque l’installation 
est terminée, fermez le programme 
d’installation. 

Suppression de Pro Tools LE

Si vous souhaitez supprimer Pro Tools LE de 
votre ordinateur, utilisez la commande Ajouter 
ou supprimer des programmes.

Pour supprimer Pro Tools LE :

1  Choisissez Démarrer > Paramètres > Panneau 
de configuration. 

2  En mode Affichage classique, cliquez deux fois 
sur l’icône Ajouter ou supprimer des 
programmes 

– ou –

En mode Affichage des catégories, cliquez sur 
Outils d’administration, puis sur Ajouter ou 
supprimer des programmes. 

3  Dans la liste des programmes installés, 
sélectionnez Digidesign Pro Tools LE.

4  Cliquez sur le bouton Modifier/Supprimer.

5  Sélectionnez Supprimer, puis cliquez sur 
Suivant.

6  Cliquez sur OK pour supprimer Pro Tools LE.

Vous pouvez exporter des fichiers SDII ou 
les convertir à l’importation, mais vous ne 
pouvez pas les utiliser dans des sessions 
Pro Tools sous Windows.

L’ensemble du formatage et de la 
maintenance des disques HFS/HFS+ doit 
s’effectuer lorsque le lecteur est relié à un 
Macintosh.

Pour plus d’informations sur MacOpener et 
les limitations de ses performances, 
consultez le Guide de référence Pro Tools.
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Lancement de Pro Tools LE
Lorsque vous lancez Pro Tools pour la première 
fois, vous êtes invité à saisir un code 
d’autorisation pour valider votre logiciel.

Pour valider le logiciel Pro Tools :

1  Cliquez deux fois sur l’application 
Pro Tools LE dans le dossier Pro Tools, qui se 
trouve dans le dossier Digidesign.

2  Entrez le code d’autorisation dans la boîte de 
dialogue qui s’affiche, en insérant les espaces 
appropriés, puis cliquez sur Validate.

Le code d’autorisation se trouve sur la page 
intérieure de la couverture de ce guide. 

Configuration de Pro Tools LE

Paramètres du système Pro Tools

Pro Tools  LE permet de régler les performances 
de votre système en modifiant les paramètres 
système qui affectent sa puissance lors des 
opérations de traitement, de lecture et 
d’enregistrement.

Dans la plupart des cas, les paramètres par 
défaut de votre système fournissent des 
performances optimales, mais vous pouvez 
souhaiter les régler afin que le système puisse 
prendre en charge de longues sessions et des 
sessions à traitement intensif de Pro Tools. 

Taille du buffer matériel

La taille du buffer matériel (H/W Buffer Size) 
contrôle la taille du cache matériel utilisée pour 
effectuer les tâches de traitement hôte, telles que 
le traitement des effets des plug-in temps réel 
(RTAS). La taille du buffer matériel par défaut est 
de 256 échantillons. 

◆ Des valeurs moins élevées réduisent la latence 
d’écoute et sont adaptées à l’enregistrement 
d’entrée en direct. 

◆ Des valeurs plus élevées permettent 
d’effectuer un traitement audio plus avancé et 
d’appliquer un plus grand nombre d’effets. 
De plus, elles sont utiles lorsque vous mixez et 
que vous utilisez davantage de plug-in RTAS.

Pour modifier la taille du buffer matériel :

1  Choisissez Setups > Playback Engine. 

2  Dans le menu contextuel H/W Buffer Size, 
sélectionnez la taille du buffer matériel, en 
échantillons.

3  Cliquez sur OK.

En plus d’entraîner une réponse de l’écran 
plus lente et un monitoring latent, des 
valeurs élevées de taille de buffer peuvent 
affecter la précision de l’automation des 
plug-in, les données de Mute et les 
pistes MIDI.

Boîte de dialogue Playback Engine pour Mbox
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Pourcentage d’utilisation du 
processeur

Le pourcentage d’utilisation du processeur 
(CPU Usage Limit) contrôle le pourcentage de 
ressources du processeur alloué aux tâches de 
traitement hôte de Pro Tools. Il est fixé par 
défaut sur 65 pour cent. 

◆ Un pourcentage d’utilisation du processeur 
élevé permet d’allouer davantage de puissance 
de traitement à Pro Tools et s’avère utile lorsque 
vous jouez de larges sessions ou que vous utilisez 
davantage de plug-in temps réel. 

◆ En attribuant une valeur peu élevée au 
paramètre CPU Usage Limit, vous limitez 
l’impact du traitement de Pro Tools sur d’autres 
tâches utilisant intensivement le processeur, 
telles que le traçage d’écrans. Ceci est utile 
lorsque la réponse de système est très lente ou 
que d’autres applications sont en cours 
d’utilisation en même temps que Pro Tools.

Pour modifier le pourcentage d’utilisation du 
processeur :

1  Choisissez Setups > Playback Engine. 

2  Dans le menu contextuel CPU Usage Limit, 
sélectionnez le pourcentage de puissance du 
processeur à allouer à Pro Tools. 

3  Cliquez sur OK.

Taille du buffer de lecture DAE

La taille du buffer de lecture DAE (DAE Playback 
Buffer Size) spécifie la quantité de mémoire 
utilisée par DAE pour gérer les buffers, ce qui a 
des conséquences sur les performances du 
système.

◆ L’allocation d’un buffer de lecture DAE de 
plus grande taille peut augmenter la densité 
d’édition par session. Cependant, un buffer de 
plus grande taille risque de retarder le début de 
la lecture ou de l’enregistrement, et il peut 
également provoquer un retard lors d’une 
édition en cours de lecture.

◆ Un buffer de lecture DAE de petite taille peut 
améliorer la vitesse de lecture et 
d’enregistrement. Cependant, une mémoire de 
buffer plus réduite risque de rendre la lecture et 
l’enregistrement moins fiables avec des disques 
durs plus lents.

Pour modifier la taille du buffer de lecture DAE :

1  Choisissez Setups > Playback Engine. 

2  Dans le menu contextuel DAE Playback 
Buffer, sélectionnez une taille de buffer. 
La configuration de mémoire requise pour 
chaque paramètre s’affiche dans la partie 
inférieure de la boîte de dialogue Playback 
Engine.

3  Cliquez sur OK. 

4  Si Pro Tools nécessite davantage de mémoire 
système pour le buffer de lecture DAE, vous êtes 
invité à redémarrer l’ordinateur.

L’augmentation du pourcentage 
d’utilisation du processeur risque d’allonger 
le temps de réponse à l’écran des 
ordinateurs plus lents.
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Paramètres matériels Pro Tools

Pro Tools LE permet de sélectionner la 
fréquence d’échantillonnage par défaut, le 
format d’entrée et la source d’horloge de votre 
système.

Fréquence d’échantillonnage par 
défaut

La valeur de la fréquence d’échantillonnage 
(Sample Rate) apparaît dans la boîte de dialogue 
Hardware Setup en tant que valeur par défaut 
lorsque vous créez une session. Ce paramètre 
n’est pas disponible si une session est ouverte. 

Pour modifier la fréquence d’échantillonnage par 
défaut :

1  Assurez-vous qu’aucune session de Pro Tools 
n’est ouverte.

2  Choisissez Setups > Hardware Setup.

3  Dans le menu contextuel Sample Rate, 
sélectionnez une fréquence d’échantillonnage.

4  Cliquez sur OK.

Source d’entrée des canaux 1 et 2

La boîte de dialogue Hardware Setup de 
Pro Tools permet de configurer deux entrées 
dans Mbox (Channel 1-2 Input Source) 
permettant de recevoir des signaux d’entrées 
analogiques ou numériques. 

Pour sélectionner le format d’entrée des canaux 1 
et 2 pour Mbox :

1  Choisissez Setups > Hardware Setup.

2  Choisissez le format d’entrée des canaux 1 et 2 
en effectuant l’une des opérations suivantes :

• Sélectionnez Analog si vous envoyez un 
signal Micro, Ligne ou Instrument via des 
connecteurs TRS ou XLR de 1/4 de pouce 
sur Mbox

– ou –

• Choisissez S/PDIF si vous envoyez un 
signal à partir d’un périphérique 
numérique vers l’entrée S/PDIF sur Mbox.

Source d’horloge

La boîte de dialogue Hardware Setup de 
Pro Tools permet de sélectionner la source 
d’horloge du système (Clock Source).

Internal : si vous enregistrez un signal 
analogique directement dans Mbox, la pratique 
habituelle consiste à utiliser la source d’horloge 
interne de Pro Tools. La source d’horloge passe 
automatiquement en mode Internal lorsque 
vous réglez Ch. 1–2 Input Source sur Analog. 

SPDIF : si vous transférez du matériel vers 
Pro Tools à partir d’un périphérique numérique 
externe, la pratique habituelle consiste à 
synchroniser Pro Tools vers ce périphérique. 
La source d’horloge passe automatiquement en 
mode SPDIF lorsque vous réglez Ch. 1–2 Input 
Source sur SPDIF.

Vous pouvez modifier la fréquence 
d’échantillonnage lors de la création d’une 
session Pro Tools en sélectionnant une 
fréquence différente dans la boîte de 
dialogue New Session (reportez-vous à la 
section « Lancement d’une session », 
page 44).

Boîte de dialogue Hardware Setup pour Mbox
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Pour sélectionner la source d’horloge :

1  Sélectionnez Setups > Hardware Setup.

2  Dans le menu contextuel Clock Source, 
sélectionnez la source d’horloge. 

3  Cliquez sur OK. 

Configuration de I/O Setup

La boîte de dialogue I/O Setup vous permet de 
marquer les chemins de signaux d’entrée, de 
sortie, d’insert et de bus de Pro Tools LE. 
La boîte de dialogue I/O Setup fournit une 
représentation graphique de l’assignation des 
entrées, sorties et signaux de Mbox. 

Les paramètres par défaut d’E/S de Pro Tools LE 
vous permettent de démarrer. Si vous souhaitez 
renommer les chemins d’E/S par défaut, allez 
dans le menu I/O Setup.
T

Autres paramètres Pro Tools

Les paramètres ci-dessous sont décrits en détail 
dans le Guide de référence Pro Tools. 

Indicateurs de volume de DigiBase : si vous 
utilisez Pro Tools 6, utilisez le navigateur de 
l’espace de travail pour désigner les disques durs 
et les volumes en tant que volumes 
d’enregistrement, de lecture et 
d’enregistrement, ou de transfert. 
Ces paramètres déterminent la fonction de 
chaque volume sur votre système. Pour plus 
d’informations, reportez-vous au Guide DigiBase. 

Allocation de disque : choisissez Setup > Disk 
Allocation pour désigner les disques durs et les 
volumes de stockage (enregistrement) des pistes 
Pro Tools. Les pistes enregistrent les données 
dans le volume que vous leur avez assigné en 
respectant la configuration indiquée dans la 
boîte de dialogue Disk Allocation. 

Votre périphérique d’entrée numérique doit 
être connecté et sous tension pour que la 
synchronisation de Pro Tools avec ce 
périphérique se réalise avec succès. S’il n’est 
pas sous tension, laissez la source d’horloge 
définie sur Internal (interne).

Reportez-vous au Guide de référence de 
Pro Tools (ou sélectionnez Help > Pro Tools 
Reference Guide) pour obtenir des 
informations sur l’attribution de nouveaux 
noms aux chemins d’E/S.

Après avoir configuré Pro Tools LE et le 
système, il est recommandé d’enregistrer 
une image du système à l’aide de Norton 
Ghost. En effet, ce logiciel permet de 
sauvegarder et de rappeler des 
configurations du système et des paramètres 
connus comme étant satisfaisants, ce qui 
facilite la récupération en cas de problèmes 
ultérieurs.
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chapitre 3

Configuration Macintosh

L’installation de Mbox sur un ordinateur 
Macintosh comprend les étapes suivantes :

1  Configuration des paramètres système Apple 
(reportez-vous à la section « Paramètres système 
Apple », page 19).

2  Installation de Pro Tools LE (reportez-vous à la 
section « Installation du logiciel Pro Tools LE », 
page 21).

3  Redémarrage de l’ordinateur.

4  Connexion de Mbox à l’ordinateur (reportez-
vous à la section « Connexion de Mbox à 
l’ordinateur », page 24).

5  Configuration du système (reportez-vous à la 
section « Configuration de Pro Tools LE », 
page 25).

6  Etablissement de connexions audio avec 
Mbox (pour des informations détaillées, 
consultez le Chapitre 4, « Connexion du 
studio »).

Paramètres système Apple
Pour garantir des performances Pro Tools LE 
optimales, configurez votre ordinateur Mac OS à 
l’aide des paramètres suivants, avant d’installer 
le logiciel Pro Tools. 

Paramètres système pour 
Mac OS X

Les paramètres suivants assurent des 
performances et une compatibilité optimales 
pour les systèmes fonctionnant sous Mac OS X. 

N’utilisez pas la fonction de mise à jour 
logicielle automatique de Mac OS X, car 
cela peut entraîner l’installation de 
composants qui n’ont pas été approuvés 
pour Pro Tools. Pour obtenir des détails sur 
les versions validées de Mac OS, reportez-
vous aux informations de compatibilité les 
plus récentes sur le site Web de Digidesign 
(www.digidesign.com).
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Pour configurer Mac OS X pour Pro Tools LE :

1  Assurez-vous d’être connecté en tant 
qu’administrateur sur l’ordinateur où vous 
souhaitez installer Pro Tools LE. Pour obtenir 
des informations détaillées sur les privilèges 
d’administrateur sous Mac OS X, reportez-vous 
à votre documentation Apple. 

2  Dans le menu Pomme, sélectionnez 
Préférences Système, puis cliquez sur 
Économiseur d’énergie. 

3  Cliquez sur l’onglet Suspendre et désactivez la 
fonction Économiseur d’énergie en réglant la 
fonction de veille sur Jamais. 

4  Retournez dans Préférences Système et cliquez 
sur Mise à jour de logiciels. 

5  Désélectionnez la case Rechercher 
automatiquement les MÀJ lorsque vous êtes 
connecté à un réseau.

6  Fermez la boîte de dialogue Mise à jour de 
logiciels. 

7  Passez à la section « Installation de Pro Tools 
sur Mac OS X », page 21. 

Paramètres système pour 
Mac OS 9

Les paramètres suivants assurent des 
performances et une compatibilité optimale 
pour les systèmes fonctionnant sous Mac OS 9. 

Pour configurer Mac OS 9 pour Pro Tools LE :

1  Dans le tableau de bord Mémoire, procédez 
comme suit :

• Dans la section Mémoire virtuelle, 
sélectionnez le bouton radio Désactivée.

• Dans la section Disque virtuel, sélectionnez 
le bouton radio Désactivé.

• Dans la section Mémoire cache, 
sélectionnez le bouton radio Personnalisée 
et tapez la valeur 512 Ko.

2  Dans le tableau de bord Économies d’énergie, 
réglez les options de suspension d’activité sur 
Jamais. 

3  Si vous procédez à l’installation de Pro Tools 
sur un Macintosh PowerBook, cliquez sur 
l’onglet Paramètres avancés dans le tableau de 
bord Économies d’énergie et vérifiez que 
l’option d’itération du processeur est désactivée.

4  Dans le tableau de bord Apparence, procédez 
comme suit :

• Cliquez sur l’onglet Polices et réglez 
l’option Grande police système sur 
Chicago. Désélectionnez également 
l’option Lisser les polices à l’écran.

• Cliquez sur Son et sélectionnez Aucune 
dans le menu contextuel Banque de sons.

5  Dans le tableau de bord Gestionnaire 
d’extensions, sélectionnez Mac OS 9.x (base) 
dans le menu contextuel Configuration.

6  Cliquez sur Dupliquer, nommez le nouvel 
ensemble Pro Tools, puis cliquez sur OK. 

7  Cliquez sur Redémarrer pour redémarrer 
l’ordinateur.

8  Passez à la section « Installation de Pro Tools 
sur Mac OS 9 », page 22. 

Tableau de bord Gestionnaire d’extensions
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Configuration et maintenance 
du disque dur
Il est recommandé de démarrer avec un lecteur 
audio venant d’être initialisé. Il est également 
conseillé de défragmenter régulièrement votre 
lecteur audio pour garantir des performances 
stables.

Si vous utilisez un disque dur SCSI, vous pouvez 
l’initialiser avec le logiciel ExpressStripe 
(Mac OS X) ou ExpressPro-Tools (Mac OS) 
d’ATTO, inclus avec le CD d’installation de 
Pro Tools LE. Si vous utilisez un disque dur 
ATA/IDE ou FireWire, initialisez-le avec le 
logiciel Disk Utility (Mac OS X) ou Drive Setup 
(Mac OS 9), fourni avec votre logiciel système 
Apple. 

Enregistrement déconseillé sur les 
lecteurs système

Bien qu’il soit possible d’enregistrer sur votre 
lecteur dans Pro Tools, ceci est généralement 
déconseillé. Les performances d’enregistrement 
et de lecture sur les lecteurs système sont 
amoindries, ce qui se traduit par un nombre 
inférieur de pistes et de plug-in. Vous ne devez 
enregistrer sur des lecteurs système qu’en cas de 
nécessité, par exemple si votre ordinateur ne 
comporte qu’un seul disque dur.

Installation du logiciel 
Pro Tools LE
Après avoir configuré les paramètres système 
Apple, vous pouvez installer Pro Tools LE.

Installation de Pro Tools sur 
Mac OS X

Pour installer Pro Tools LE sur Mac OS X :

1  Assurez-vous que vous êtes connecté en tant 
qu’administrateur pour le compte sur lequel 
vous souhaitez installer Pro Tools LE. Pour 
obtenir des informations détaillées sur les 
privilèges d’administrateur sous Mac OS X, 
reportez-vous à votre documentation Apple. 

2  Insérez le CD d’installation de 
Pro Tools LE 6.0 dans votre lecteur de CD-ROM. 
Cliquez deux fois sur Install Pro Tools LE. 

3  Saisissez votre mot de passe administrateur et 
cliquez sur OK pour authentifier l’installation. 

4  Dans la fenêtre d’installation, sélectionnez 
Pro Tools LE for Mbox et définissez 
l’emplacement d’installation sur votre disque 
dur de démarrage.

5  Cliquez sur Install. 

6  Lorsque l’installation est terminée, cliquez sur 
Restart

– ou –

Cliquez sur Continue pour installer un logiciel 
ou de la documentation supplémentaire, et 
redémarrez votre ordinateur lorsque vous avez 
terminé.

Avant d’installer Pro Tools LE, assurez-
vous que votre ensemble d’extensions 
Pro Tools est créé. Après l’installation du 
logiciel Pro Tools, un certain nombre 
d’extensions Digidesign sont ajoutées au 
nouvel ensemble d’extensions Pro Tools. 
Assurez-vous que cet ensemble d’extensions 
Pro Tools est activé lorsque vous utilisez 
Pro Tools. 
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Pour utiliser des périphériques MIDI avec 
Pro Tools, configurez votre installation MIDI 
avec l’utilitaire de configuration Apple Audio 
MIDI Setup (AMS). Reportez-vous à l’Annexe B, 
« Configuration d’AMS (Mac OS X 
uniquement) ».

Suppression de Pro Tools LE de 
Mac OS X

Utilisez le CD d’installation pour supprimer 
Pro Tools LE de votre ordinateur. 

Pour supprimer Pro Tools LE de votre ordinateur :

1  Assurez-vous que vous êtes connecté en tant 
qu’administrateur au compte sur lequel vous 
souhaitez installer Pro Tools LE. Pour obtenir 
des informations détaillées sur les privilèges 
d’administrateur sous Mac OS X, reportez-vous 
à votre documentation Apple. 

2  Insérez le CD d’installation de 
Pro Tools LE 6.0 dans votre lecteur de CD-ROM. 
Cliquez deux fois sur Install Pro Tools LE. 

3  Saisissez votre mot de passe administrateur et 
cliquez sur OK pour authentifier l’installation. 

4  Dans la fenêtre du programme d’installation, 
choisissez Uninstall dans le menu contextuel et 
cliquez sur Uninstall. 

5  Cliquez sur Quit pour fermer la fenêtre du 
programme d’installation.

Installation de Pro Tools sur 
Mac OS 9

Pour installer Pro Tools LE sur Mac OS 9 : 

1  Insérez le CD d’installation de 
Pro Tools LE 5.2.1 dans votre lecteur de 
CD-ROM. Cliquez deux fois sur Install 
Pro Tools LE 5.2.1.

2  Dans la fenêtre du programme d’installation, 
sélectionnez Pro Tools LE 5.2.1 for Mbox et 
assurez-vous que votre disque dur de démarrage 
est spécifié comme emplacement pour 
l’installation. 

3  Si vous souhaitez utiliser Mbox avec des 
applications compatibles avec le Gestionnaire 
audio d’Apple, sélectionnez l’option Digidesign 
Control Panel. Reportez-vous à l’Annexe D, 
« Tableau de bord Digidesign (Mac OS 9 
uniquement) »

4  Cliquez sur Install.

5  Lorsque l’installation est terminée, effectuez 
l’une des opérations suivantes :

• Cliquez sur Quit et installez OMS 
(consultez la section « Installation 
d’OMS », page 23), si ce n’est déjà fait

– ou –

• Cliquez sur Restart. 

Pro Tools installe le plug-in Rocket dans le 
dossier des plug-in du navigateur Web. 
Veillez à sélectionner le dossier 
d’applications de votre navigateur Web 
lorsque vous y êtes invité. 
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Suppression de Pro Tools LE de 
Mac OS 9

Utilisez le CD d’installation pour supprimer 
Pro Tools LE de votre ordinateur. 

Pour supprimer Pro Tools LE de votre ordinateur :

1  Insérez le CD d’installation de 
Pro Tools LE 5.2.1 dans votre lecteur de 
CD-ROM. Cliquez deux fois sur Install 
Pro Tools LE 5.2.1. 

2  Dans la fenêtre du programme d’installation, 
choisissez Uninstall dans le menu contextuel et 
cliquez sur Uninstall. 

3  Cliquez sur Quit pour fermer la fenêtre du 
programme d’installation.

Installation d’OMS
Mac OS 9 uniquement

Pour utiliser Pro Tools LE sur Mac OS 9, vous 
devez d’abord installer et configurer le système 
Open Music System (OMS), qui est fourni sur le 
CD d’installation de Pro Tools. 

Pour installer OMS :

1  Insérez le CD d’installation de 
Pro Tools LE 5.2.1 dans votre lecteur de 
CD-ROM. 

2  Ouvrez le dossier OMS Installer et cliquez 
deux fois sur le programme d’installation 
d’OMS.

3  Dans la fenêtre d’installation, sélectionnez 
l’Installation standard et indiquez 
l’emplacement d’installation sur votre disque 
dur de démarrage. Cliquez sur Install.

4  Suivez les instructions d’installation à l’écran.

5  Lorsque l’installation est terminée, cliquez sur 
Restart.

Installation de sessions de 
démonstration
(facultatif)

Le CD d’installation de Pro Tools comprend des 
sessions de démonstration vous permettant de 
vérifier le bon fonctionnement du système. 

Pro Tools LE 6.0. Comprend une seule session 
de démonstration. 

Pro Tools LE 5.2.1. Comprend les deux sessions 
de démonstration suivantes :

◆ Pro Tools SoundCheck Mbox est une session 
simple de 12 pistes, adaptée au systèmes lents.

◆ Be There Mbox est une session de 20 pistes plus 
sophistiquée qui utilise également une banque 
de sons SampleCell.

Vous devez installer OMS, même si vous ne 
souhaitez pas utiliser MIDI lors de vos 
sessions Pro Tools. Si MIDI n’est pas 
installé, l’application Pro Tools ne peut pas 
fonctionner.

Pour plus d’informations sur la 
configuration d’OMS, reportez-vous à 
l’Annexe C, « Configuration d’OMS 
(Mac OS 9 uniquement) ».



Introduction à Mbox24

Pour installer une session de démonstration :

1  Insérez le CD d’installation de Pro Tools LE 
dans votre lecteur de CD. Recherchez l’icône 
d’installation des sessions de démonstration et 
cliquez deux fois dessus. 

2  Sélectionnez la session de démonstration que 
vous souhaitez installer. 

3  Définissez l’emplacement d’installation sur 
votre lecteur audio et cliquez sur Install.

4  L’installation étant terminée, cliquez sur Quit.

A propos des composants de 
DigiStudio
Pro Tools LE 5.2.1 uniquement

Lors de l’installation de Pro Tools LE, un dossier 
appelé DigiStudio est créé dans le dossier 
Pro Tools. Ce dossier contient les bibliothèques 
et les fichiers nécessaires à l’utilisation conjointe 
de Pro Tools et de DigiStudio. Ces composants 
ne sont pas nécessaires à l’exécution de 
Pro Tools. Pour plus d’informations, reportez-
vous au Guide DigiStudio.

Connexion de Mbox à 
l’ordinateur
Avant de lancer le logiciel Pro Tools LE, 
connectez Mbox à l’ordinateur.

Pour connecter Mbox à votre ordinateur :

1  Raccordez l’extrémité la plus fine du câble USB 
fourni au port USB port du Mbox.

2  Connectez l’autre extrémité du câble USB à 
tout port USB disponible sur votre ordinateur.

Lancement de Pro Tools LE
Lorsque vous lancez Pro Tools LE pour la 
première fois, vous êtes invité à entrer un code 
d’autorisation pour valider votre logiciel.

Pour valider le logiciel Pro Tools LE :

1  Cliquez deux fois sur l’application 
Pro Tools LE, dans le dossier Pro Tools, qui se 
trouve dans le dossier Digidesign.

2  Avec Mac OS 9, si OMS n’a pas déjà été 
configuré, vous êtes invité à configurer un 
nouveau Studio Setup. Pour connaître les 
procédures spécifiques, reportez-vous à 
l’Annexe C, « Configuration d’OMS (Mac OS 9 
uniquement) ».

3  Entrez le code d’autorisation dans la boîte de 
dialogue en veillant à ne pas omettre d’espace.

Composants de DigiStudio

Mbox ne fonctionne pas correctement si 
vous le connectez à un hub USB. Si vous 
devez absolument utiliser un hub pour 
d’autres périphériques USB, utilisez un port 
hub distinct ; Mbox doit être branché à un 
port dédié sur l’ordinateur pour fonctionner 
correctement.
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Le numéro de série est imprimé sur la page 
intérieure de la couverture de ce guide. 

4  Cliquez sur Validate.

Si le témoin USB du panneau avant de Mbox ne 
s’allume pas une fois que vous l’avez connecté et 
que vous avez lancé Pro Tools, essayez de 
débrancher le câble USB du port, puis de le 
brancher de nouveau.

Si le témoin USB ne s’allume pas, arrêtez 
l’ordinateur, débranchez Mbox et démarrez à 
nouveau l’ordinateur. Une fois l’ordinateur 
redémarré, connectez à nouveau Mbox, puis 
lancez Pro Tools. 

Configuration de Pro Tools LE

Paramètres du système Pro Tools

Pro Tools LE permet de régler les performances 
de votre système en modifiant les paramètres 
système qui affectent sa puissance lors des 
opérations de traitement, de lecture et 
d’enregistrement. 

Dans la plupart des cas, les paramètres par 
défaut de votre système fournissent des 
performances optimales, mais vous pouvez 
souhaiter les régler afin que le système puisse 
prendre en charge de longues sessions et des 
sessions à traitement intensif de Pro Tools. 

Hardware Buffer Size

La taille du buffer matériel (H/W Buffer Size) 
contrôle la taille du cache matériel utilisée pour 
effectuer les tâches de traitement hôte, telles que 
le traitement des effets des plug-in en temps réel 
(RTAS). 

◆ Une taille de buffer matériel réduite améliore 
la précision de l’automation et du timing des 
données MIDI, mais limite le nombre de plug-in 
RTAS et de configurations de mixage que vous 
pouvez exécuter sur votre système.

◆ Une taille de buffer matériel importante 
permet d’effectuer un traitement de l’audio et 
d’appliquer des effets à l’audio, et elle est utile 
lorsque vous utilisez des configurations de 
mixage plus importantes ou un nombre plus 
élevé de plug-in RTAS sur votre système.

Pour modifier la taille du buffer matériel :

1  Choisissez Setups > Playback Engine. 

2  Dans le menu contextuel H/W Buffer Size, 
sélectionnez la taille de buffer matériel, en 
échantillons.

3  Cliquez sur OK. 

Un buffer de grande taille entraîne une 
réponse plus lente de l’écran et une certaine 
latence d’écoute, et risque d’affecter la 
précision de l’automation des plug-in, les 
données de Mute et les pistes MIDI.

Boîte de dialogue Playback Engine pour Mbox 
(Pro Tools 6.0)
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CPU Usage Limit

Le pourcentage d’utilisation du processeur 
contrôle le pourcentage de ressources de 
processeur allouées à l’hôte Pro Tools traitant 
des tâches.

◆ Avec Pro Tools 5.2.1, le pourcentage 
d’utilisation du processeur est de 85 pour cent. 

◆ Avec Pro Tools 6.0, le pourcentage maximal 
d’utilisation du processeur est de 85 pour cent 
pour les ordinateurs à processeur unique et de 
99 pour cent pour les ordinateurs à processeur 
multiple (le réglage 99 % attribue un processeur 
entier à Pro Tools).

Pour modifier le pourcentage d’utilisation du 
processeur :

1  Choisissez Setups > Playback Engine. 

2  Dans le menu contextuel CPU Usage Limit, 
sélectionnez le pourcentage de traitement du 
processeur que vous souhaitez allouer à 
Pro Tools. 

3  Cliquez sur OK.

• Un pourcentage faible d’utilisation du 
processeur limite l’effet du traitement de 
Pro Tools sur d’autres tâches requérant une 
utilisation intensive du processeur, telles 
que le traçage d’écrans. Cela peut s’avérer 
utile lorsque la réponse de système est très 
lente ou que d’autres applications sont en 
cours d’utilisation en même temps que 
Pro Tools.

• Un pourcentage élevé d’utilisation du 
processeur permet d’allouer davantage de 
puissance de traitement à Pro Tools et 
s’avère utile lorsque vous lisez des sessions 
de grande taille ou que vous utilisez 
davantage de plug-in en temps réel. 

DAE Playback Buffer Size

La taille du buffer de lecture DAE spécifie la 
quantité de mémoire utilisée par DAE pour gérer 
les buffers, ce qui a des conséquences sur les 
performances du système.

◆ Un buffer de lecture DAE de petite taille peut 
améliorer la vitesse de lecture et 
d’enregistrement. Cependant, une mémoire de 
buffer plus réduite risque de rendre la lecture et 
l’enregistrement moins fiables avec des disques 
durs plus lents.

◆ L’allocation d’un buffer de lecture DAE de 
plus grande taille peut augmenter la densité 
d’édition par session. Cependant, un buffer de 
plus grande taille risque de retarder le début de 
la lecture ou de l’enregistrement, et peut 
également provoquer un retard lors d’une 
édition en cours de lecture.

Boîte de dialogue Playback Engine pour Mbox 
(Pro Tools 5.2.1)

L’augmentation du pourcentage 
d’utilisation du processeur peut entraîner 
un ralentissement de l’affichage des écrans 
sur des ordinateurs lents.
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Pour modifier la taille du buffer de lecture DAE 
dans Pro Tools 6.0 :

1  Choisissez Setups > Playback Engine.

2  Dans le menu contextuel DAE Playback 
Buffer, sélectionnez une taille de buffer.

3  Cliquez sur OK. 

Pour modifier la taille de buffer de lecture DAE 
dans Pro Tools 5.2.1 :

1  Lancez DAE. Si Pro Tools est déjà en cours 
d’exécution, lancez l’application DAE en la 
sélectionnant dans le menu Application. 

2  Sélectionnez File > Set Playback Buffer Size.

3  Sélectionnez une taille de buffer de lecture. 

4  Cliquez sur OK.

5  Fermez Pro Tools s’il est en cours d’exécution. 
Le nouveau paramètre du buffer s’applique 
lorsque vous lancez de Pro Tools à nouveau.

Paramètres matériels Pro Tools

Pro Tools LE permet de sélectionner la 
fréquence d’échantillonnage par défaut, le 
format d’entrée et la source d’horloge de votre 
système.

Fréquence d’échantillonnage par 
défaut

La valeur de la fréquence d’échantillonnage 
(Sample Rate) apparaît en tant que valeur par 
défaut lorsque vous créez une nouvelle version. 
Ce paramètre est disponible dans la boîte de 
dialogue Hardware Setup uniquement lorsque 
aucune session n’est ouverte. 

Pour modifier la fréquence d’échantillonnage par 
défaut dans Pro Tools 6.0 :

1  Assurez-vous qu’aucune session de Pro Tools 
n’est ouverte. 

2  Sélectionnez Setups > Hardware Setup. 

3  Choisissez la fréquence d’échantillonnage par 
défaut en cliquant sur le bouton Sample Rate 
correspondant. 

4  Cliquez sur OK.

Boîte de dialogue DAE Playback Buffer Size 
(Pro Tools 5.2.1)

Vous pouvez modifier la fréquence 
d’échantillonnage lors de la création d’une 
nouvelle session Pro Tools en sélectionnant 
une fréquence d’échantillonnage différente 
dans la boîte de dialogue New Session 
(consultez la section « Lancement d’une 
session », page 44).

Boîte de dialogue Hardware Setup pour Mbox 
(Pro Tools 6.0)
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Pour modifier la fréquence d’échantillonnage par 
défaut dans Pro Tools 5.2.1 :

1  Assurez-vous qu’aucune session de Pro Tools 
n’est ouverte. 

2  Choisissez Setups > Hardware.

3  Dans le menu contextuel Sample Rate, 
sélectionnez une fréquence d’échantillonnage.

4  Cliquez sur OK.

Format d’entrée des canaux 1 et 2

La boîte de dialogue Hardware Setup de 
Pro Tools permet de configurer deux entrées 
dans Mbox (Channel 1-2 Input Format) 
permettant de recevoir des signaux d’entrées 
analogiques ou numériques. 

Pour sélectionner le format d’entrée des canaux 1 
et 2 pour Mbox :

1  Sélectionnez Setups > Hardware Setup 
(Pro Tools 6.0) ou Setups > Hardware 
(Pro Tools 5.1.1).

2  Choisissez le format d’entrée des canaux 1–2 
en effectuant l’une des opérations suivantes :

• Choisissez Analog si vous envoyez un 
signal Microphone, Ligne ou Instrument 
via des connecteurs TRS ou XLR de 1/4 de 
pouce sur Mbox. 

• Choisissez S/PDIF (RCA) si vous envoyez 
un signal à partir d’un périphérique 
numérique vers l’entrée S/PDIF sur Mbox.

Source d’horloge

La boîte de dialogue Hardware Setup de 
Pro Tools permet de sélectionner la source 
d’horloge du système (Clock Source), appelée 
« Sync Mode » dans Pro Tools 5.2.1.

Internal : si vous enregistrez un signal 
analogique directement dans Mbox, la pratique 
habituelle consiste à utiliser la source d’horloge 
interne de Pro Tools. La source d’horloge passe 
automatiquement en mode Internal lorsque 
vous réglez Ch. 1–2 Input Source sur Analog. 

SPDIF/RCA : si vous transférez du matériel vers 
Pro Tools à partir d’un périphérique numérique 
externe, la pratique habituelle consiste à 
synchroniser Pro Tools vers ce périphérique. 
La source d’horloge bascule automatiquement 
sur SPDIF/RCA lorsque vous réglez l’entrée de 
canaux 1 et 2 sur SPDIF/RCA.

Pour sélectionner la source d’horloge :

1  Choisissez Setups > Hardware Setup 
(Pro Tools 6.0) ou Setups > Hardware 
(Pro Tools 5.2.1).

2  Sélectionnez une source d’horloge 
(Pro Tools 6.0) ou choisissez la source d’horloge 
dans le menu contextuel Sync Mode 
(Pro Tools 5.2.1).

3  Cliquez sur OK. 

Boîte de dialogue Hardware Setup pour Mbox 
(Pro Tools 5.2.1)

Votre périphérique d’entrée numérique doit 
être connecté et sous tension pour que la 
synchronisation de Pro Tools avec ce 
périphérique se réalise avec succès. S’il n’est 
pas sous tension, laissez la source d’horloge 
définie sur Internal (interne).
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Configuration des E/S

La boîte de dialogue I/O Setup vous permet de 
marquer les chemins de signaux d’entrée, de 
sortie, d’insert et de bus de Pro Tools LE. 
La boîte de dialogue I/O Setup fournit une 
représentation graphique de l’assignation des 
entrées, sorties et signaux de Mbox. 

Les paramètres par défaut d’E/S de Pro Tools LE 
vous permettent de démarrer. Si vous souhaitez 
renommer les chemins d’E/S par défaut, allez 
dans le menu I/O Setup.

Pour renommer les chemins d’E/S dans 
I/O Setup :

1  Choisissez Setups > I/O Setups.

2  Cliquez sur l’onglet Input, Output, Insert ou 
Bus pour afficher les connexions 
correspondantes. 

3  Pour modifier le nom d’un chemin ou d’un 
sous-chemin, cliquez deux fois directement sur 
le nom du chemin, tapez le nouveau nom et 
appuyez sur la touche Retour. 

4  Cliquez sur OK. 

Configuration de DigiStudio
(Pro Tools 5.2.1 uniquement)

Pour configurer DigiStudio pour une 
collaboration en ligne, reportez-vous au Guide 
DigiStudio après avoir installé et configuré votre 
système Mbox Pro Tools. 

Autres paramètres Pro Tools

Les paramètres ci-dessous sont décrits en détail 
dans le Guide de référence Pro Tools. 

Les indicateurs de volume de DigiBase : si vous 
utilisez Pro Tools 6, utilisez le navigateur de 
l’espace de travail pour désigner les disques durs 
et volumes en tant que volumes 
d’enregistrement, de lecture et d’enregistrement 
ou de transfert. Ces paramètres déterminent la 
fonction de chaque volume sur votre système. 
Pour plus d’informations, reportez-vous au 
Guide DigiBase. 

Allocation de disque : choisissez Setup > Disk 
Allocation pour désigner les disques durs et 
volumes de stockage (enregistrement) des pistes 
Pro Tools. Les pistes enregistrent les données 
dans le volume que vous leur avez assigné en 
respectant la configuration indiquée dans la 
boîte de dialogue Disk Allocation. 

Boîte de dialogue I/O Setup pour Mbox, onglet Input

Pour obtenir des informations sur 
l’attribution de nouveaux noms aux 
chemins d’E/S, reportez-vous au Guide de 
référence de Pro Tools.
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chapitre 4

Connexion du studio

Ce chapitre explique comment connecter un système Mbox à un système d’écoute, un enregistreur 
numérique et des sources audio destinées à l’enregistrement.

La configuration du studio varie en fonction de l’équipement qu’il comprend. Les schémas ci-dessous 
illustrent deux configurations possibles.

Figure 1.  Configuration de micro studio Mbox exécutant Pro Tools LE sur un PC

haut-parleurs sous tension

sorties

console

DAT ou E/S numérique

micro

Mbox

instrument

câble 

unité 

casque

ordinateur

moniteur

du moniteur

S/PDIF enregistreur de CD

USB

FireWire



Introduction à Mbox32

Figure 2.  Configuration de micro studio Mbox exécutant Pro Tools LE sur un ordinateur portable
lap

top

Mbox

instrument

câble 

unité 

ordinateur portable casque

USB

FireWire



Chapitre 4 : Connexion du studio 33

Caractéristiques du panneau 
avant de Mbox

Le panneau avant de Mbox intègre les éléments 
suivants :

Voyant 48V

Allumé, ce voyant indique que l’alimentation 
fantôme de 48 V est active au niveau des entrées 
Mic/Line, qui permettent de fournir aux micros 
l’alimentation fantôme nécessaire à leur 
fonctionnement. L’alimentation fantôme est 
activée au moyen de la touche indiquant 48 V 
située en haut du panneau arrière de Mbox.

A propos de l’alimentation fantôme

Les micros dynamiques (tels que les Shure SM57) 
ne requièrent pas d’alimentation fantôme et ne 
subissent aucun dommage s’ils en reçoivent. 
La plupart des micros à condensateur 
(par exemple, AKG C3000) ont besoin d’une 
alimentation fantôme pour fonctionner. 

En cas de doute concernant l’alimentation 
fantôme de votre micro, consultez le fabricant 
de votre micro ou lisez la documentation s’y 
rapportant.

Figure 3.  Panneau avant de Mbox
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L’alimentation fantôme peut être utilisée en 
toute sécurité avec la plupart des micros, 
mais elle risque d’endommager les micros à 
ruban. Veillez à la désactiver et patientez 
au moins dix secondes avant de connecter 
ou de déconnecter un micro à ruban.
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Sélecteur de source

Ces touches permettent de sélectionner trois 
types d’entrée :

• Mic (micro) pour les entrées XLR ;

• Line (ligne) pour les signaux de niveau ligne 
sur des entrées TRS ou TS ;

• Inst (instrument) pour une autre connexion 
TRS ou TS 1/4 de pouce.

Pour plus d’informations, reportez-vous à la 
section « Audio analogique », page 38. 

Commandes de gain

Ces boutons permettent de régler les niveaux de 
gain d’entrée des entrées Mic/Line.

Voyants de crête

Ces voyants se déclenchent juste avant que les 
niveaux d’écrêtage analogiques soient atteints. 
En d’autres termes, si les voyants de crête 
clignotent de temps à autre, cela signifie que le 
signal est sur le point d’atteindre les niveaux 
d’écrêtage, mais ils n’indiquent pas forcément 
qu’il y a distorsion ou écrêtage au niveau du 
signal.

Voyant USB

Le voyant USB indique que le pilote Mbox a 
lancé la lecture par l’unité. Lorsque ce voyant est 
allumé, les données audio peuvent circuler à 
l’intérieur ou à l’extérieur du système.

Voyant S/PDIF

Ce voyant indique que les canaux 1 et 2 ont été 
réglés pour recevoir un signal d’entrée 
numérique plutôt qu’analogique. Reportez-vous 
à la section « Les ports d’E/S S/PDIF sont des 
connecteurs asymétriques à 2 conducteurs 
phono (RCA) qui utilisent un flux de données 
numériques de 24 bits, à deux canaux. », 
page 36.

Commande Mix (Ratio)

Mbox vous donne la possibilité de contrôler les 
signaux d’entrée pendant l’enregistrement, sans 
le retard induit par les convertisseurs A/D/A et le 
traitement effectué sur des applications hôtes. 

Le bouton Mix permet de contrôler cette écoute 
à latence zéro, ce qui vous permet de mélanger, 
et de régler le rapport d’écoute entre les entrées 
analogiques Mbox et la lecture Pro Tools. 
Le bouton Mix n’a aucun effet lorsque vous 
utilisez les entrées numériques S/PDIF, étant 
donné qu’il gère le contrôle du signal avant qu’il 
n’atteigne les convertisseurs A/N.

Pour écouter uniquement le signal d’entrée 
Source, tournez le bouton complètement vers la 
gauche, en position Input. Pour n’écouter que le 
signal de sortie Pro Tools, tournez le bouton 
complètement vers la droite, en position 
Playback.

Le signal de sortie provenant de la commande 
Mix est acheminé directement vers les sorties de 
ligne TRS et se répercute au niveau des ports 
casque et des ports de sortie S/PDIF.

La possibilité de mélanger et de contrôler les 
niveaux relatifs de la lecture Pro Tools et des 
entrées analogues directes sans latence s’avère 
particulièrement utile dans le cas 
d’enregistrements fractionnés (overdubbing). 
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Touche Mono

La touche Mono fait la somme des signaux 
d’entrée contrôlés, mais n’a aucun effet sur 
l’écoute de la lecture Pro Tools ou des sorties 
principales. Ceci est utile lorsque vous 
enregistrez une entrée mono tout en écoutant 
une lecture stéréo ou pour vérifier les relations 
de phase entre les entrées stéréo. 

Contrôle lors d’un enregistrement fractionné

La possibilité de centrer les signaux d’entrée 
(au lieu de les écouter en les soumettant à un 
panoramique jusqu’aux extrémités gauche et 
droite sur les sorties casque) permet de créer un 
mixage d’écoute de focalisation accrue qui 
facilite la minimisation des désagréments lors 
d’enregistrements fractionnés. 

Si vous êtes amené à contrôler conjointement 
des micros stéréo, des synthétiseurs stéréo ou 
toute autre paire de source dotée d’un équilibre 
confortable, il est probable que vous ne 
souhaitiez pas utiliser la touche Mono. 

Contrôle des relations de phase

Vous pouvez également utiliser la touche Mono 
pour vérifier brièvement la phase entre le signal 
d’entrée de la source 1 et celui de la source 2.

Lorsque les deux signaux d’entrée sont 
déphasés, le fait d’appuyer sur la touche Mono 
produit un son « sourd » résultant de 
l’annulation de phase. Ce test rapide effectué à 
l’aide de la touche Mono peut permettre d’éviter 
l’apparition de problèmes ultérieurs lors du 
mixage de ces pistes. Le contrôle régulier des 
relations de phase à l’aide de la touche Mono 
peut également vous aider à savoir comment 
placer le micro de façon optimale.

Gain de casque

Cette commande permet de régler le niveau de 
sortie des ports Casque avant et arrière, qui 
émettent le signal acheminé vers les sorties 1 et 
2 dans Pro Tools LE et reflète les sorties de ligne.

Sortie casque du panneau avant

Utilisez le port casque du panneau avant pour 
connecter un casque stéréo doté d’un mini-
connecteur de 1/8 de pouce. 

Si vous insérez un connecteur stéréo de 1/4 de 
pouce dans le port casque du panneau arrière, le 
port casque de 1/8 de pouce du panneau avant 
est désactivé. 
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Caractéristiques du panneau 
arrière de Mbox

Le panneau arrière de Mbox intègre les éléments 
suivants :

Sortie casque du panneau arrière

Utilisez cette sortie casque pour connecter un 
casque stéréo doté d’un connecteur stéréo de 
1/4 de pouce. 

Si vous insérez un connecteur de 1/4 de pouce 
dans le port casque situé sur le panneau arrière, 
le port casque de 1/8 de pouce du panneau 
avant est désactivé. 

Touche 48V

Ce bouton permet d’activer l’alimentation 
fantôme au niveau des entrées Mic pour les 
micros dont le fonctionnement requiert 
l’alimentation fantôme. 

Port USB

Ce port USB v1.1 standard permet de connecter 
l’ordinateur à Mbox. Un câble USB standard est 
livré avec le système. 

Mbox est compatible avec les ports USB 2.0. 
Cependant, le bus USB 2.0 passe à la vitesse 
USB v.1.1 plus lente pour fonctionner avec 
Mbox.

E/S numérique S/PDIF

Les ports d’E/S S/PDIF sont des connecteurs 
asymétriques à 2 conducteurs phono (RCA) qui 
utilisent un flux de données numériques de 
24 bits, à deux canaux.

Le format d’interface numérique Sony/Philips 
(S/PDIF) est utilisé sur de nombreux 
enregistreurs de CD et enregistreurs DAT 
destinés aux professionnels et au grand public. 
Pour éviter une interférence RF, utilisez un câble 
coaxial de 75 ohms pour les transferts S/PDIF et 
maintenez une longueur de câble de 10 m 
maximum.

Figure 4.  Panneau arrière de Mbox
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Avant de brancher un micro, vérifiez l’état 
du voyant 48V, situé sur le panneau avant 
de Mbox. La touche 48V se trouve sur le 
panneau arrière, au-dessus du port USB et 
peut facilement être activée par accident 
lors de la connexion du câble USB.
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Sorties de ligne

Ces sorties prennent en charge les connexions 
TRS symétriques ou TS asymétriques de 1/4 de 
pouce. Ces sorties peuvent être connectées à une 
console de mixage, directement à un système 
d’écoute tel qu’un amplificateur de puissance 
stéréo ou à toute autre destination stéréo afin 
d’écouter le mixage.

Les sorties de ligne 1 et 2 lisent les données 
audio acheminées vers les sorties analogiques 1 
et 2 depuis Pro Tools, respectivement. 
Ces sorties analogiques sont dotées de 
convertisseurs analogiques-numériques 24 bits.

Source 1 et 2

Ces entrées symétriques/asymétriques prennent 
en charge une gamme étendue de niveaux 
d’entrée, dont les entrées micro, instrument ou 
de niveau de ligne. Les ports sont compatibles 
avec les connecteurs d’entrée audio de type XLR, 
TRS ou TS. Pour chaque canal, la commande de 
gain permet de régler le signal d’entrée, 
conjointement avec la touche Source. 

Inserts 1 et 2

Mbox fournit un point d’insertion sur chaque 
canal d’entrée. Ces ports TRS envoient et 
retournent le signal du canal d’entrée 
directement après le préamplificateur, mais 
avant le convertisseur A/N. Ceci permet 
l’insertion de processus analogiques, tels que des 
compresseurs ou des égaliseurs, qui sont 

généralement utilisés comme inserts sur les 
consoles d’enregistrement analogiques 
conventionnelles. Reportez-vous à la section 
« Utilisation des inserts analogiques », page 39.

Etablissement de connexions 
de signaux avec Mbox
Vous pouvez utiliser Mbox dans diverses 
configurations audio. Cette section décrit 
l’établissement de connexions de base pour les 
éléments ci-dessous.

• Ecoute

• Entrée analogique et numérique en 
enregistrement

• Inserts matériels

• Mixage final

Ecoute de l’audio

Etant donné que Mbox intègre deux ports 
casque, vous avez le choix entre le port TRS de 
1/4 de pouce situé sur le panneau arrière et le 
port de 1/8 de pouce, situé sur le panneau avant.

Les sorties de ligne de Mbox lisent l’audio qui est 
acheminé depuis Pro Tools vers les sorties 
analogiques 1 et 2. Ces sorties peuvent fournir 
des sorties gauche et droite vers un 
magnétophone à deux pistes pour des mixages 
finaux, ou vers une autre destination stéréo. 

Les sorties de ligne de Mbox sont reliées à des 
convertisseurs N/A 24 bits capables de produire 
un signal maximal de +4 dBu/+2 dBV (signal 
symétrique/asymétrique). Les connecteurs sont 
des ports TRS, et les connecteurs TS 
asymétriques sont également pris en charge.

Les connecteurs XLR ne prennent en charge 
que les entrées de niveau micro. Autrement 
dit, si vous choisissez Line ou Inst, la partie 
XLR du port est ignorée. De même, si vous 
choisissez Mic, la partie 1/4 de pouce du 
connecteur est ignorée.
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Pour brancher le casque :

1  Connectez le casque au port correspondant 
sur Mbox. La sortie casque du panneau avant 
accepte un connecteur de 1/8 de pouce, et la 
sortie casque du panneau arrière accepte un 
connecteur TRS stéréo de 1/4 de pouce. 

2  Réglez le volume du casque à l’aide du bouton 
de gain de casque.

Pour effectuer le branchement sur une stéréo :

■ A l’aide de câbles de 1/4 de pouce, connectez 
les sorties de ligne, situées sur le panneau arrière 
de Mbox, aux entrées correspondantes sur votre 
console de stéréo. 

Pour brancher des haut-parleurs avec un 
amplificateur de puissance ou des haut-parleurs 
d’écoute auto-alimentés :

■ A l’aide de câbles de 1/4 de pouce, connectez 
les sorties de ligne, situées sur le panneau arrière 
de Mbox, aux entrées correspondantes sur votre 
console de mixage, votre amplificateur de 
puissance ou vos haut-parleurs auto-alimentés. 

Connexion de sources audio à 
Mbox pour l’enregistrement

Il est possible de connecter directement des 
sources numériques et analogiques à Mbox.

Audio analogique

Les signaux analogiques sont produits par des 
micros, des synthétiseurs, des consoles de 
mixage et des instruments dotés de bobines 
magnétiques. 

Parmi ces sources, les signaux les plus faibles 
sont générés par les micros et instruments à 
bobines magnétiques et ils nécessitent 
généralement une amplification maximale. 
Les claviers, préamplificateurs et consoles de 
mixage produisent de l’audio de « niveau 
ligne », qui varie d’un équipement à l’autre 
entre les normes -10 dBV et +4 dBu. 

Pour s’adapter à ces différentes sources, Mbox 
est doté de niveaux d’entrées et d’impédance 
qu’il est possible d’alterner, avec réglage du gain 
pour chaque canal d’entrée.

Pour connecter une source audio analogique :

1  Branchez le câble XLR ou TRS directement sur 
l’entrée Mic/Line 1 ou 2 de Mbox. Ces entrées 
acceptent les connecteurs XLR ou TRS. 

2  Faites défiler les choix à plusieurs reprises en 
appuyant sur le bouton Source de chaque canal, 
jusqu’à ce que le voyant correspondant à votre 
choix s’allume.

La sortie casque Mbox peut produire des 
niveaux de sortie très élevés. Une écoute 
prolongée peut entraîner des problèmes 
d’audition. Réglez le volume du casque avec 
modération.

Une seule sortie casque peut être utilisée à la 
fois. Lorsque deux casques sont connectés 
aux sorties casque, la sortie casque du 
panneau avant est coupée. 

Les systèmes stéréo utilisent souvent des 
connecteurs RCA. Vous pouvez utiliser un 
adaptateur ou un câble spécial pour 
convertir les connecteurs TRS ou TS de Mbox 
en connecteurs RCA utilisables avec votre 
stéréo.
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Pour activer l’alimentation fantôme :

■ Si votre micro nécessite une alimentation 
fantôme, assurez-vous d’abord qu’il est 
connecté, puis appuyez sur la touche Phantom 
Power (48V).

Utilisation des inserts analogiques

Les canaux d’entrée analogiques de Mbox 
comportent tous un point d’insertion TRS dédié. 
Ces inserts matériels provoquent la rupture du 
chemin d’entrée analogique avant qu’il ne soit 
converti en signal numérique et envoyé à 
Pro Tools. C’est en général à ce moment-là qu’il 
est souhaitable d’insérer un compresseur, un 
égaliseur ou tout autre effet série qu’il faut placer 
en ligne dans le chemin de signal. 

Etant donné qu’il s’agit d’inserts matériels, qui 
acheminent le chemin de signal avant qu’il 
n’atteigne Pro Tools, il n’est pas possible 
d’effectuer une insertion sur les pistes dans une 
session Pro Tools.

Pour insérer un périphérique, vous devez vous 
munir d’un câble d’insert doté d’un connecteur 
TRS à une extrémité et possédant deux 
connecteurs asymétriques à l’autre. 
Le connecteur rattaché à la fiche correspond à 
l’envoi et celui qui est rattaché à l’anneau 
correspond au retour.

Pour insérer un périphérique à un chemin 
de signal :

1  Vous devez vous munir d’un câble possédant, 
à une extrémité, un connecteur TRS et à l’autre, 
deux connecteurs asymétriques. Le type de 
connecteur asymétrique est déterminé par les 
entrées du périphérique.

2  Repérez les connecteurs asymétriques et 
déterminez celui qui correspond à la fiche et 
celui qui correspond à l’anneau. 

3  Branchez le connecteur asymétrique 
correspondant à la fiche sur le port d’entrée du 
périphérique.

4  Branchez le connecteur asymétrique 
correspondant à l’anneau sur le port de sortie du 
périphérique.

5  Insérez le connecteur TRS dans le port 
d’insertion de votre choix sur Mbox.

Audio numérique

Mbox comporte des entrées et sorties 
numériques pour l’audio numérique au format 
S/PDIF. 

A propos de S/PDIF

L’E/S S/PDIF (Sony/Philips Digital Interchange 
Format) est disponible sur la plupart des DAT, 
lecteurs de disques compacts et autres 
périphériques numériques. Chaque connexion 
S/PDIF fournit 2 canaux d’audio numérique 
avec une capacité de 24 bits. 

Pour connecter un périphérique S/PDIF sur Mbox :

1  Utilisez deux câbles coaxiaux de 75 ohms 
équipés de connecteurs mâles RCA à chacune de 
leurs extrémités (achetés séparément). 

2  Connectez la sortie S/PDIF du périphérique au 
port d’entrée S/PDIF de Mbox, et l’entrée S/PDIF 
du périphérique à la sortie correspondante sur 
Mbox.

3  Choisissez Setups > Hardware Setup et 
sélectionnez les options appropriées dans les 
listes déroulantes Sync Mode et Ch 1–2 Input. 

L’activation de l’alimentation fantôme fait 
circuler 48 V sur les deux entrées micro. 
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Duplication des sorties en S/PDIF

Pro Tools LE utilise la duplication des sorties 
S/PDIF pour « dupliquer » automatiquement 
l’audio envoyé vers les sorties de ligne 1 et 2 sur 
les sorties RCA S/PDIF. Ceci est utile si vous 
écoutez un mixage à l’aide de vos sorties de ligne 
et que vous l’enregistrez en même temps sur un 
périphérique S/PDIF externe.

Connexion d’un appareil 
analogique pour le mixage 
final
Après l’enregistrement et le mixage des sessions 
dans Pro Tools, vous pouvez effecteur un 
mixage final vers un DAT, un magnétophone ou 
tout autre périphérique d’enregistrement stéréo 
à deux pistes.

Connexion d’un deck analogique

Branchez votre enregistreur (magnétophone ou 
autre dispositif analogique) sur les sorties de 
ligne situées à l’arrière de Mbox. Acheminez le 
signal des sorties de ligne 1 et 2 vers les entrées 
gauche et droite respectives de l’enregistreur. 
Ces sorties sont des ports TRS. Vous aurez besoin 
de câbles d’adaptateurs si votre appareil de 
mixage final possède des entrées RCA.

Connexion d’un deck numérique

Si vous possédez un enregistreur de CD, un DAT 
ou tout autre périphérique recevant un signal 
S/PDIF, connectez-le aux ports RCA d’entrée et 
de sortie S/PDIF situés à l’arrière de Mbox.

Connexions MIDI
En ajoutant une interface compatible MIDI à 
votre système, vous pouvez tirer partie de toutes 
les fonctions MIDI de Pro Tools LE, y compris 
des fonctions d’enregistrement et de 
modification de pistes MIDI.

Les interfaces USB et MIDI série sont 
entièrement compatibles avec Pro Tools.

Sur les systèmes Macintosh, les interfaces série 
MIDI requièrent un adaptateur de port modem-
série compatible. En effet, les filtres d’expansion 
série équipés d’une interface PCI ne 
fonctionnent pas avec des interfaces MIDI série 
sur les systèmes Macintosh. Pour plus 
d’informations sur la compatibilité de ces 
adaptateurs, visitez le site Web de Digidesign 
(www.digidesign.com/compato).

• Pour les systèmes Macintosh exécutant 
Mac OS X, consultez l’Annexe B, 
« Configuration d’AMS (Mac OS X 
uniquement) » pour obtenir des informations 
sur la configuration de Audio MIDI Setup et de 
vos périphériques MIDI. 

• Pour les systèmes Macintosh exécutant 
Mac OS 9, consultez l’Annexe C, 
« Configuration d’OMS (Mac OS 9 
uniquement) » pour obtenir des informations 
sur la configuration de Open Music System et de 
vos périphériques MIDI.
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Pour connecter des périphériques MIDI à votre 
système :

1  Branchez l’interface MIDI à votre ordinateur 
en suivant les instructions de la documentation 
de votre interface MIDI.

2  Installez le logiciel pilote MIDI requis par 
l’interface MIDI. Une fois le matériel et le 
logiciel de l’interface MIDI installés, vérifiez 
qu’ils fonctionnent correctement en suivant les 
procédures de la documentation fournie avec 
l’interface.

3  Connectez la sortie MIDI OUT de votre 
périphérique ou contrôleur MIDI à l’entrée 
MIDI IN de votre interface MIDI. 

4  Connectez l’entrée MIDI IN du dispositif ou 
du contrôleur MIDI à la sortie MIDI OUT de 
l’interface MIDI. 
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chapitre 5

Utilisation de Pro Tools LE

Ce chapitre présente les principales fenêtres et 
fonctions de Pro Tools LE, ainsi que la 
procédure d’enregistrement audio de base 
(reportez-vous à la section « Enregistrement de 
base », page 55). 

Toutes les fonctions décrites dans ce chapitre 
sont expliquées en détail dans le Guide de 
référence Pro Tools. Vous pouvez accéder à ce 
guide au format PDF en le sélectionnant dans le 
menu Application de Pro Tools (Pro Tools 6) ou 
dans le menu Help de Pro Tools (Pro Tools 5). 
Reportez-vous à ce guide et aux index qu’il 
contient pour obtenir des informations 
supplémentaires sur les fonctions Pro Tools LE. 

Principes de base des 
sessions
Les projets Pro Tools LE sont créés et enregistrés 
sous forme de sessions. Celles-ci stockent toutes 
les données audio, MIDI et autres informations 
relatives à la session. Les fichiers audio et de 
fondu sont stockés dans les sous-dossiers du 
dossier de la session.

Fichier de session, dossiers Audio Files et Fade Files
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Lancement d’une session

Pour créer une session :

1  Lancez Pro Tools LE.

2  Choisissez File > New Session. 

3  Dans la boîte de dialogue New Session, réglez 
la fréquence d’échantillonnage, la résolution et 
les options correspondant à la nouvelle session.

4  Sélectionnez l’emplacement où vous 
souhaitez enregistrer la session. Si vous utilisez 
des disques durs externes avec le système 
Pro Tools, veillez à sélectionner le disque 
approprié dans la boîte de dialogue New Session.

5  Attribuez un nom à la session.

6  Cliquez sur Save. Les fenêtres Mix, Edit et 
Transport de la nouvelle session s’affichent 
(reportez-vous à la Figure 5, page 45).

Fenêtres principales

Les fenêtres Mix, Edit et Transport constituent 
l’espace de travail principal de Pro Tools. Vous 
pouvez afficher ces fenêtres en les sélectionnant 
dans le menu Windows. 

Fenêtre Mix : affiche la console de mixage 
Pro Tools et ses commandes de fader standard 
pour le volume, le panoramique, la mise en solo, 
la coupure de son et l’acheminement du signal. 

Fenêtre Edit : affiche les pistes de la session le 
long de la graduation temporelle pour l’édition 
de données audio, MIDI et d’automation. 

Transport : affiche les boutons de transport 
standard, à savoir les boutons de lecture, d’arrêt, 
d’avance et de retour rapide, de pause et 
d’enregistrement. Cette fenêtre peut également 
inclure les affichages Counter et MIDI Control.

Espace de travail (Pro Tools 6 uniquement) : 
le navigateur de l’espace de travail (Workspace) 
est une fonction DigiBase disponible dans 
Pro Tools version 6 ou ultérieure. Pour plus 
d’informations, reportez-vous au Guide DigiBase. 

Boîte de dialogue New Session

Appuyez sur la touche Commande et sur le 
signe égal (=) pour basculer de la fenêtre 
Edit à la fenêtre Mix et inversement.
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Règles

Pro Tools LE fournit différentes règles de 
sélection en tant que règles temporelles. 
Les règles temporelles, affichées en haut de la 
fenêtre Edit, incluent Bars:Beats, Minutes:Seconds 
et Samples. La règle temporelle courante 
détermine le format du compteur principal et 
fournit la base de la grille de la fenêtre Edit. 

Pour sélectionner une règle temporelle :

■ Cliquez sur le nom de la règle en haut à 
gauche de la fenêtre Edit (Bars:Beats, 
Minutes:Seconds ou Samples).

Figure 5.  Fenêtres de session principales

Pistes

Pistes

Règles

Fenêtre Transport

Fenêtre MixFenêtre Edit



Introduction à Mbox46

Définition d’un tempo

Vous pouvez définir un tempo de session à l’aide 
des commandes d’événements de tempo ou des 
commandes de tempo MIDI de la fenêtre 
Transport étendue. 

Pour insérer un événement de tempo :

1  Choisissez Windows > Show Tempo/Meter.

2  Dans la partie supérieure de la fenêtre 
Tempo/Meter Change, sélectionnez Tempo 
Change dans le menu contextuel.

3  Saisissez la valeur BPM de la session et tapez 
1|1|000 comme emplacement (Location), de 
façon à ce que la valeur de tempo ainsi insérée 
remplace celle par défaut.

4  Pour baser la valeur BPM sur une autre valeur 
de note (telle qu’une croche plutôt qu’une 
noire), sélectionnez une valeur de note.

5  Cliquez sur Apply pour insérer le nouvel 
événement de tempo.

Utilisation du clic (métronome)

Pro Tools propose une option de clic MIDI 
(MIDI Click) qui permet d’utiliser un 
périphérique MIDI externe pour émettre un clic 
audio. Cette fonction peut être activée ou 
désactivée à partir de la fenêtre Transport et 
vous pouvez la configurer dans la boîte de 
dialogue Click Options du menu MIDI. 

Pour configurer et activer le clic Pro Tools :

1  Choisissez MIDI > Click Options.

2  Configurez les paramètres de clic en fonction 
des besoins de la source audio MIDI. 

3  Vous pouvez activer ou désactiver le clic 
pendant l’enregistrement ou la lecture à l’aide 
du bouton en forme de métronome, au niveau 
de l’affichage des commandes MIDI dans la 
fenêtre Transport. 

Fenêtre Tempo/Meter Change

Commandes de clic et de tempo de la fenêtre Transport

Clic

Commandes de tempo
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Enregistrement de sessions

Vous souhaiterez probablement enregistrer 
votre travail au fur et à mesure de la création 
d’une session (ajout de pistes et modification 
des paramètres par exemple). Pro Tools propose 
trois méthodes d’enregistrement. 

Pourenregistrer une session :

■ Choisissez File > Save Session, Save Session As 
ou Save Session Copy In. 

Save Session : permet d’enregistrer la session 
ouverte sans la fermer.

Save Session As : crée une copie du fichier de 
session auquel vous pouvez attribuer le nom de 
votre choix, sans le refermer pour que vous 
puissiez continuer à l’utiliser. Il ne crée pas de 
nouveau dossier de fichiers audio (Audio Files) 
ni de nouveau dossier de fichiers de fondu (Fade 
Files). Cela peut s’avérer utile si vous souhaitez 
tester différents arrangements en cours de 
session sans modifier la session originale.

Save Session Copy In : enregistre des copies du 
fichier de la session et des fichiers que vous 
utilisez dans la session en cours. Ceci peut 
s’avérer utile lors de la création d’une copie 
finale de la session qui n’inclut pas les fichiers 
audio ou de fondu que vous n’utilisez plus.

Affichage et configuration des 
ressources système

Vous pouvez modifier des paramètres concrets 
du système Pro Tools pour optimiser les 
performances système.

Boîte de dialogue Playback Engine

La boîte de dialogue Playback Engine permet de 
régler la taille du buffer du système et d’affecter 
davantage de puissance de processeur au 
système Pro Tools. 

Pour configurer les ressources système :

■ Choisissez Setups > Playback Engine. Pour 
plus d’informations, consultez le Chapitre 2, 
« Configuration Windows » ou le Chapitre 3, 
« Configuration Macintosh », selon l’ordinateur 
que vous possédez.

Fenêtre System Usage

La fenêtre System Usage affiche les informations 
sur la charge du processeur, l’utilisation des 
ressources DSP et les performances globales du 
disque (Macintosh uniquement), ce qui vous 
permet d’estimer les capacités de traitement de 
votre système. 

Pour afficher les ressources et l’utilisation du 
système :

■ Choisissez Windows > Show System Usage. 

Vumètres de la fenêtre System Usage
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Commandes de transport
La fenêtre Transport fournit un accès à toutes les 
commandes de transport de Pro Tools LE. Il est 
possible d’afficher ou de masquer certaines 
commandes de transport dans cette fenêtre.

Pour afficher la fenêtre Transport :

■ Choisissez Window > Show Transport 
Window. 

Pour configurer la fenêtre Transport :

■ Choisissez Display > Transport Window 
Shows et sélectionnez les options d’affichage. 

En affichage standard, la fenêtre Transport 
comprend les commandes les plus utilisées, 
notamment les boutons de lecture et d’arrêt. 
En affichage étendu, elle contient les 
indicateurs de pré-roll/post-roll, de début, de fin 
et de durée correspondant à la zone sélectionnée 
dans la Timeline, ainsi que le sélecteur 
Transport Master. 

Vous pouvez également choisir d’afficher les 
commandes MIDI ci-dessous dans la fenêtre 
Transport. Wait for Note (attente de note), Click 
(clic), Countoff (décompte), MIDI Merge (fusion 
MIDI), Conductor (chef d’orchestre), Meter 
(vumètre) et Tempo. 

Pour lancer et arrêter la lecture :

1  Cliquez sur le bouton de lecture de la fenêtre 
Transport pour commencer la lecture.

2  Cliquez sur le bouton d’arrêt de la fenêtre 
Transport pour arrêter la lecture.

Fenêtre Transport

En ligne

Retour 
rapide

Arrêt

Lecture

Enregistre-
ment

Retour à zéro

Fin

Avance rapide

Commandes MIDI de la fenêtre Transport

Utilisez la barre d’espace de votre clavier 
pour lancer et arrêter la lecture.

Pro Tools LE commence la lecture à partir 
de l’endroit où se trouve le curseur ou depuis 
le début de la sélection en cours. 
Les paramètres en cours des commandes 
Link Edit et Timeline Selection du menu 
Operations affectent également la lecture. 
Reportez-vous au Guide de référence 
Pro Tools pour de plus amples 
informations.

Clic

Chef d’orchestre Vumètre

Commandes de 
tempo

Décompte
Fusion MIDI

Attente de 
note
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Mode d’accès à un 
emplacement à l’intérieur 
d’une session
Pro Tools LE fournit plusieurs façon d’accéder à 
un endroit précis à l’intérieur d’une session, 
notamment à l’aide de la souris ou par saisie 
d’un emplacement concret dans l’un des 
compteurs. 

Pour accéder à un emplacement concret depuis la 
fenêtre Edit :

1  Dans le menu Operations, vérifiez que les 
options Link Edit et Timeline Selection sont 
activées.

2  Activez le sélecteur situé en haut de la fenêtre 
Edit en cliquant dessus.

3  Cliquez sur une piste ou sur la règle 
temporelle. Le curseur apparaît à l’emplacement 
sélectionné et les compteurs affichent 
l’emplacement correspondant.

Pour accéder à un emplacement concret à l’aide 
des compteurs :

1  Cliquez dans le compteur principal et saisissez 
l’emplacement de votre choix à l’aide du clavier 
de votre ordinateur. 

2  Appuyez sur Return. 

Emplacements mémoire

Les emplacements mémoire constituent une 
autre méthode de navigation dans les sessions. 
Ils s’affichent comme des marqueurs sous les 
règles temporelles.

Pour définir un emplacement mémoire :

1  Appuyez sur la touche Entr du pavé 
numérique pendant la lecture ou lorsque celle-ci 
est interrompue (ou cliquez sur l’icône Markers). 

Dans la fenêtre New Memory Location, vous 
pouvez définir un marqueur, stocker un 
emplacement ou n’importe quelle combinaison 
de paramètres disponibles. Ces paramètres 
incluent la hauteur de pistes, l’activation de 
groupe, les valeurs de pré-roll et de post-roll, 
ainsi que l’affichage et le masquage des pistes. 

Outils d’édition de la fenêtre Edit

Navigation à l’aide du sélecteur dans la fenêtre Edit

Sélecteur

Cliquez sur une piste ou une règle temporelle

Navigation à l’aide du compteur

Vous pouvez également appuyer sur la 
touche * du pavé numérique au lieu de 
cliquer sur le compteur. 
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2  Définissez les paramètres de l’emplacement 
mémoire et cliquez sur OK. 

Pour accéder à un emplacement mémoire 
enregistré : 

1  Choisissez Windows > Show Memory 
Locations.

2  Dans la fenêtre Memory Locations, cliquez sur 
le nom de l’emplacement mémoire.

Affichage et zoom

Lorsque les pistes sont affichées dans la fenêtre 
Edit, vous pouvez régler verticalement ou 
horizontalement leur hauteur, ainsi que le 
zoom, en utilisant le sélecteur de hauteur de 
piste et le zoom.

Pour modifier la hauteur de piste :

■ Cliquez sur le sélecteur de hauteur de piste et 
sélectionnez une taille d’affichage dans le menu 
contextuel. 

Pour effectuer un zoom avant sur une partie de 
piste dans la fenêtre Edit :

1  Cliquez sur le zoom.

2  Cliquez sur le zoom ou faites-le glisser pour 
effectuer un zoom avant horizontal sur une 
piste ou une règle. 

Fenêtre New Memory Location

Zoom et sélecteur de hauteur de piste de la fenêtre Edit

De nombreuses commandes, telles que la 
modification de la hauteur de piste, peuvent 
être appliquées simultanément à plusieurs 
pistes. Pour appliquer une opération à 
toutes les pistes, maintenez la touche 
Option enfoncée. Pour l’appliquer à toutes 
les pistes sélectionnées, maintenez les 
touches Maj et Option enfoncées.

Présélections de 
zoom

 Boutons de zoom

Zoom

Sélecteur de 
hauteur de piste
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Pour effectuer un zoom avant ou arrière par 
incréments :

■ Cliquez sur le bouton de Zoom approprié :

• Flèche gauche (zoom arrière horizontal)

• Flèche droite (zoom avant horizontal)

• Boutons Waveform et MIDI pour 
augmenter ou réduire le zoom vertical du 
type de piste correspondant (audio ou 
MIDI)

Pro Tools fournit également cinq boutons de 
Zoom prédéfinis. Vous pouvez les utiliser pour 
revenir instantanément aux niveaux de zoom 
par défaut ou pour définir le niveau 
d’agrandissement de chaque présélection, 
session par session.

Pour utiliser une présélection de zoom :

■ Cliquez sur le bouton de présélection de zoom 
approprié (1 à 5).

Pour enregistrer une nouvelle présélection de 
zoom :

■ Cliquez à l’aide de la touche Commande sur 
un numéro de présélection de Zoom pour 
procéder à l’enregistrement du Zoom horizontal 
et vertical sur cette présélection. 

Utilisation des emplacements mémoire pour la 
commande de zoom

Les emplacements mémoire Pro Tools 
permettent de stocker de nombreux attributs au 
niveau de chaque marqueur ou emplacement 
mémoire, notamment les paramètres de hauteur 
de piste et de zoom. Pour effectuer des zooms 
avant et arrière à l’aide du pavé numérique, vous 
pouvez utiliser des emplacements qui ne sont ni 
des marqueurs ni des sélections, mais dont les 
paramètres de hauteur de piste et de zoom 
(ou autres options) sont activés.

Pistes
Pro Tools LE permet de créer de l’audio et des 
pistes MIDI pour l’enregistrement, le prémixage, 
l’acheminement, l’automation et l’édition de 
données audio et MIDI.

Pro Tools propose quatre types de pistes : pistes 
audio, entrées auxiliaires, faders principaux et 
pistes MIDI. Les pistes audio, entrées auxiliaires 
et faders principaux peuvent être mono ou 
stéréo.

Pistes audio : les pistes audio (Audio Tracks) 
permettent l’enregistrement et la lecture audio 
vers et depuis le disque dur, l’écoute de l’entrée 
audio lorsque l’enregistrement est activé, ainsi 
que la modification de régions audio.

Entrées auxiliaires : canaux de mixage audio, 
utilisés pour l’entrée, le routage et le prémixage.

Faders principaux : ils fournissent des 
commandes du canal maître, ainsi que des 
options pour tout chemin de sortie ou de bus.

Pistes MIDI : les pistes MIDI (MIDI Tracks) sont 
des pistes utilisées pour l’enregistrement, la 
lecture et l’édition de données MIDI.

Pour créer une piste :

1  Choisissez File > New Track. 

2  Indiquez le nombre de pistes, le type de pistes 
et leur nature (mono ou stéréo), pour tous les 
types de pistes, à l’exception des pistes MIDI.

3  Cliquez sur Create.

Boîte de dialogue New Track
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Dans la fenêtre Mix, les pistes audio, les entrées 
auxiliaires, les faders principaux et les pistes 
MIDI s’affichent sous forme de voies verticales. 
Le type de piste est indiqué par les icônes de type 
de piste situées juste au-dessous des faders. 

Dans la fenêtre Edit, les pistes sont affichées 
horizontalement le long de la règle temporelle. 
La zone dans laquelle l’audio s’affiche pour 
chaque piste est appelée Playlist. 

Les pistes audio, les entrées auxiliaires, les faders 
principaux et les pistes MIDI peuvent être 
automatisés. 

Pistes dans la fenêtre Mix

Règles temporelles et piste audio stéréo dans la 
fenêtre Edit

Piste Entrée FaderPiste
principalauxiliaireaudio MIDI

Piste audio

Affichage
des règles 
temporelles

Piste audio stéréo dans la fenêtre Mix

Nom de la piste

Vumètre de niveau

Panoramique

Coupure de son

Indicateur d’écrêtage

Entrée
Sortie

Indicateur de volume

Commentaires sur 

Mode d’automation

Enregistre-

Mise en solo

Activation de groupe

Volume
(voyants rouges)

Ouverture de 
Sélecteur de voix

Inserts

Envois

ment

la fenêtre de sortie

la piste
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Pistes audio

Les pistes audio, les entrées auxiliaires et les 
faders principaux ont en commun un grand 
nombre de commandes. Les faders principaux 
possèdent toutes les fonctions des pistes audio 
ou des entrées auxiliaires, mais diffèrent de la 
manière suivante : 

Sélecteur d’entrée : l’affectation de sortie d’un 
fader principal détermine son entrée ou sa 
source (toujours sorties 1 et 2 sur la Mbox). 

Envois : les faders principaux ne gèrent pas les 
envois. Par conséquent, si vous souhaitez 
modifier la destination de la sortie, vous devez 
utiliser une entrée auxiliaire.

Pistes MIDI

Outre des commandes d’entrée, de sortie, de 
canal et de programme (patch) MIDI, les pistes 
MIDI possèdent des fonctions de niveau de 
piste, de mise en solo et de coupure de son. Le  
volume, la coupure de son et le panoramique de 
données MIDI peuvent également être 
automatisés à l’aide des fonctions d’automation 
de Pro Tools (pour plus d’informations, 
reportez-vous à la section « Automation du 
mixage », page 65).

Listes des régions
Toutes les régions enregistrées, importées ou 
créées lors de l’édition apparaissent dans les 
listes des régions audio et MIDI. Les régions 
peuvent être déplacées d’une liste vers des pistes 
et disposées dans n’importe quel ordre. Elles 
peuvent aussi être écoutées depuis les listes des 
régions en cliquant sur le nom de la région 
audio tout en maintenant la touche Option 
enfoncée. Les menus de la liste contextuelle 
Regions fournissent des fonctions de gestion des 
régions et des fichiers très utiles, telles que le tri, 
la sélection, l’importation et l’exportation de 
fichiers.

Listes des régions audio et MIDI

Pour plus d’informations sur les listes des 
régions, reportez-vous au Guide de référence 
Pro Tools.

Cliquez pour masquer les listes des régions

Faites glisser la bordure pour 
redimensionner la largeur 
des listes des régions

Faites glisser la 
bordure pour 
redimensionner la 
hauteur des listes 
des régions

Cliquez sur les 
noms de la liste 
pour afficher des 
menus contextuels
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Importation de données audio
Pro Tools LE permet d’importer des fichiers 
audio depuis le disque. Sur les systèmes 
Macintosh, il est également possible d’importer 
des pistes d’un CD audio. Ceci s’avère très utile 
si vous disposez de fichiers audio stockés sur 
votre disque ou si vous travaillez avec des 
bibliothèques d’échantillons contenues sur CD 
et que vous souhaitez les utiliser dans une 
nouvelle session.

Pour importer des fichiers ou des régions audio 
depuis le disque :

■ Choisissez File > Import Audio to Track pour 
importer des fichiers et des régions vers de 
nouvelles pistes audio (elles apparaissent 
également en tant que régions dans la liste des 
régions audio) 

– ou –

■ Choisissez Import Audio dans le menu 
contextuel Audio Regions List pour importer des 
fichiers et des régions dans la liste des régions 
audio uniquement.

Pour importer une piste audio CD (Pro Tools 6.0) :

1  Insérez le CD audio dans le lecteur de 
CD-ROM.

2  Choisissez Movie > Import Audio From Other 
Movie.

3  Recherchez et sélectionnez la piste audio à 
importer, puis cliquez sur Open.

4  Dans la fenêtre Track Import Window, cliquez 
sur OK. 

5  Accédez à une destination pour y rechercher la 
piste audio importée, puis cliquez sur Choose. 

Pro Tools convertit la piste audio du CD en 
fichier ayant un format, une résolution et une 
fréquence d’échantillonnage identiques à ceux 
de la session, et l’enregistre sur votre disque dur. 

Le fichier audio importé s’affiche dans la liste 
des régions audio. Vous pouvez ensuite faire 
glisser la région sur une piste de votre session.

Pour importer une piste audio d’un CD 
(Pro Tools 5.2.1) :

1  Insérez le CD audio dans le lecteur de 
CD-ROM.

2  Choisissez Movie > Import Audio From Other 
Movie.

3  Sur le CD audio, recherchez et sélectionnez la 
piste audio à importer, puis cliquez sur Convert.

4  Dans la boîte de dialogue Save, cliquez sur 
Options. 

5  Dans la boîte de dialogue Options, 
sélectionnez la fréquence d’échantillonnage, la 
résolution et le format de canal (mono ou 
stéréo) de la piste audio importée. 

Pour plus d’informations sur l’importation 
de données audio en sessions, reportez-vous 
au Guide de référence Pro Tools.

DigiBase fournit des options d’importation 
supplémentaires pour Pro Tools LE 6.0. 
Pour plus d’informations, reportez-vous au 
Guide DigiBase. 
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6  Dans la partie inférieure de la boîte de 
dialogue Options, réglez la gamme de la piste 
CD à importer en ajustant les champs de début 
et de fin.

Pour écouter une piste avant de l’importer, 
utilisez les boutons de lecture et d’arrêt. Pour 
régler le volume de lecture, déplacez le curseur 
vertical. Pour accéder à un emplacement 
spécifique sur la piste, faites glisser le curseur 
horizontal.

7  Lorsque vous êtes prêt à importer la piste 
audio, cliquez sur OK. 

8  Spécifiez un emplacement de destination sur 
le lecteur vers lequel la piste audio sera 
importée, puis cliquez sur Save. Pro Tools 
importe la piste audio du CD comme un fichier 
vidéo QuickTime et l’écrit sur votre lecteur 
audio.

9  Lorsque la fenêtre Track Import apparaît, 
cliquez sur OK.

Pro Tools convertit la piste audio afin que la 
fréquence d’échantillonnage et la résolution 
correspondent à celles de votre session et 
importe les pistes audio sélectionnées dans la 
liste des régions audio. Vous pouvez ensuite 
faire glisser les régions vers des pistes existantes.

Enregistrement de base
Cette section décrit la procédure 
d’enregistrement audio et MIDI dans 
Pro Tools LE. 

Acheminement de l’audio vers une 
piste

Pour acheminer de l’audio vers une piste :

1  Vérifiez les connexions aux instruments. 
Reportez-vous au Chapitre 4, « Connexion du 
studio » pour plus d’informations concernant la 
connexion d’instruments à la Mbox.

2  Créez une piste audio pour l’enregistrement 
en sélectionnant File > New Track. Choisissez 
une piste audio mono, puis cliquer sur Create.

3  Dans la fenêtre Mix, cliquez sur le sélecteur 
d’entrée sur la nouvelle piste. 

Dans le menu contextuel, sélectionnez l’entrée à 
enregistrer. Par exemple, sélectionnez Mic/Line 
si votre source audio est branchée à la prise de la 
Source 1 située à l’arrière de l’unité Mbox. Cette 
entrée apparaît comme In 1 dans la liste ou 
porte le nom qui a été saisi dans la boîte de 
dialogue I/O Setup.

Boîte de dialogue Audio CD Import Options

Acheminement d’une entrée vers une piste mono



Introduction à Mbox56

Réglage des niveaux d’entrée de 
la Mbox

Réglez le niveau d’entrée en utilisant les 
boutons de gain situé sur l’avant de la Mbox. 
Pour le niveau ligne ou les sources instrument, 
réglez le volume de sortie du périphérique au 
niveau maximal pouvant être atteint sans 
toutefois provoquer de distorsion de l’audio, 
puis utilisez les boutons de gain de la Mbox pour 
maximiser le signal entrant dans Pro Tools.

La clé d’un réglage approprié des niveaux 
d’entrée réside dans l’obtention d’un signal 
aussi fort que possible, sans toutefois surcharger 
les entrées Mbox ni entraîner un écrêtage 
numérique. Les signaux proches du haut du 
vumètre dans Pro Tools LE utilisent une gamme 
de bits plus étendue (les 16 ou 24 bits qui 
composent chaque échantillon d’audio). Plus la 
possibilité vous est offerte de maximiser cette 
gamme de bits sans entraîner d’écrêtage, plus la 
qualité sonore de votre composition est 
satisfaisante.

Enregistrement d’une piste audio

Pour enregistrer une piste audio :

1  Cliquez sur le bouton Rec pour une piste, 
assignez-lui une entrée et réglez les niveaux 
d’entrée de façon appropriée.

2  Choisissez Windows > Show Transport pour 
afficher la fenêtre Transport. Cliquez sur le 
bouton de retour à zéro pour lancer 
l’enregistrement depuis le début de la session. 
Vous pouvez également enregistrer selon la 
plage de temps correspondant à votre sélection 
ou à partir de l’emplacement du curseur dans la 
fenêtre Edit. 

3  Cliquez sur le bouton d’enregistrement de la 
fenêtre Transport pour activer l’enregistrement.

4  Cliquez sur le bouton de lecture ou appuyez 
sur la barre d’espace pour enregistrer sur toutes 
les pistes actives.

5  Enregistrez votre travail.

6  Cliquez sur le bouton d’arrêt dans la fenêtre 
Transport ou appuyez sur la barre d’espace 
lorsque vous avez fini l’enregistrement.

Pour lire une piste enregistrée :

1  Cliquez à nouveau sur le bouton Rec de la 
piste pour arrêter le mode enregistrement. 

2  Cliquez sur le bouton de lecture dans la 
fenêtre Transport ou appuyez sur la barre 
d’espace pour lancer la lecture.

3  Cliquez sur le bouton d’arrêt de la fenêtre 
Transport ou appuyez sur la barre d’espace pour 
arrêter la lecture.

L’écrêtage numérique survient lorsque vous 
envoyez à un dispositif audio un signal plus 
fort que celui que les circuits peuvent 
accepter. Surveillez les vumètres dans 
Pro Tools lors du réglage des niveaux 
d’entrée afin d’éviter l’écrêtage. 
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Enregistrement MIDI

Pour configurer une nouvelle piste MIDI pour 
l’enregistrement :

1  Choisissez MIDI > Input Devices, puis vérifiez 
que le périphérique d’entrée est sélectionné 
dans la fenêtre MIDI Input Enable. 

2  Choisissez File > New Track, spécifiez une piste 
MIDI, puis cliquez sur Create.

3  Dans la fenêtre Mix, cliquez sur le sélecteur de 
périphérique et de canal MIDI de la piste et 
choisissez la destination (affectation) de la piste 
MIDI en sélectionnant un port pour l’interface 
MIDI, un canal ou un périphérique dans le 
menu contextuel. Le choix dépend du système 
d’exploitation et de la version de Pro Tools que 
vous possédez.

4  Vous pouvez affecter un numéro de 
programme par défaut à la piste en cliquant sur 
le bouton Program dans la fenêtre Mix et en 
choisissant le numéro du programme et celui de 
la banque de sons que vous désirez, puis en 
cliquant sur Done. Les numéros de programme 
par défaut sont transmis lors de la lecture d’une 
piste.

5  Dans la fenêtre Mix, activez en enregistrement 
la piste MIDI.

6  Vérifiez que MIDI > MIDI Thru est 
sélectionné, puis jouez quelques notes sur votre 
contrôleur MIDI. L’instrument MIDI affecté à la 
piste doit émettre un son et les vumètres de la 
piste doivent témoigner d’une activité MIDI.

Pour enregistrer sur une piste MIDI :

1  Vérifiez que l’enregistrement de la piste MIDI 
est activé et qu’elle reçoit les données MIDI.

2  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour avoir la garantie 
que l’enregistrement commencera au début de 
la session. Vous pouvez également enregistrer en 
fonction de la plage de temps correspondant à 
votre sélection ou à partir de l’emplacement du 
curseur dans la fenêtre Edit. 

3  Cliquez sur le bouton d’enregistrement de la 
fenêtre Transport.

4  Cliquez sur le bouton de lecture dans la 
fenêtre Transport ou appuyez sur la barre 
d’espace pour lancer l’enregistrement

– ou –

Si vous utilisez l’option d’attente de note, les 
boutons de lecture, d’enregistrement et 
d’attente de note clignotent et l’enregistrement 
commence dès la réception du premier 
événement MIDI

– ou –

Si vous utilisez l’option de décompte, cliquez sur 
le bouton de lecture. Les boutons 
d’enregistrement et de lecture clignotent 
pendant le décompte, puis l’enregistrement 
commence.

5  Jouez de votre instrument MIDI.

Sélecteur de périphérique et de canal MIDI (Macintosh)
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6  A la fin de l’enregistrement, cliquez sur Arrêt 
dans la fenêtre Transport ou appuyez sur la barre 
d’espace. Les nouvelles données MIDI 
enregistrées s’affichent sous la forme d’une 
région MIDI au niveau de la piste, dans la 
fenêtre Edit et dans la liste des régions MIDI.

Pour lire une piste MIDI enregistrée:

1  Cliquez sur le bouton Rec de la piste MIDI, 
afin de désactiver le mode enregistrement.

2  Dans la fenêtre Transport, cliquez sur le 
bouton de retour à zéro pour activer la lecture 
depuis le début de la piste. Vous pouvez 
également commencer la lecture à partir de la 
plage de temps correspondant à votre sélection 
ou de l’emplacement du curseur dans la 
fenêtre Edit.

3  Cliquez sur le bouton de lecture de la fenêtre 
Transport pour commencer la lecture. Les 
données MIDI enregistrées sont lues par 
l’instrument et le canal affectés à la piste.

Ecoute des instruments MIDI sans console de 
mixage

Pour écouter la sortie analogique de vos 
instruments MIDI, vous pouvez créer une entrée 
auxiliaire. Les entrées auxiliaires fonctionnent 
comme des entrées à la fois pour les signaux 
véhiculés par des bus internes et pour les sources 
audio externes.

Pour configurer une entrée auxiliaire pour l’écoute 
MIDI :

1  Connectez la sortie audio de l’instrument 
MIDI aux entrées appropriées sur votre Mbox.

2  Choisissez File > New Track et spécifiez 1 
entrée auxiliaire mono ou stéréo, puis cliquez 
sur Create.

3  Cliquez sur le sélecteur d’entrée du canal 
d’entrées auxiliaires et choisissez l’entrée à 
laquelle votre instrument MIDI est connecté. 

4  Réglez le niveau de l’entrée auxiliaire à l’aide 
de son fader de volume.

Montage
Pro Tools LE fournit plusieurs outils pour 
l’édition audio et MIDI. Dans la fenêtre Edit, les 
pistes audio et MIDI peuvent être éditées en 
régions ou répétées à des emplacements 
différents, ce qui permet de créer des boucles, de 
réarranger des sections ou des chansons 
entières, ou d’assembler des pistes en utilisant 
des éléments provenant de plusieurs prises. 

L’édition audio ou MIDI est généralement 
utilisée pour les opérations suivantes :

• Correction ou remplacement d’erreurs

• Réarrangement de chansons et de projets

• Nettoyage du rythme et de la synchronisation 
de piste par alignement des sons avec des 
valeurs Grid, telles que les mesures et les 
temps

• Création de pistes finales à l’aide de sélections 
provenant de prises multiples (également 
appelées piste composite)

Modes et outils d’édition (avec activation du mode Slip 
et de l’outil Smart)

Modes d’édition Outils d’édition
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Modes d’édition

Pro Tools LE offre quatre modes d’édition : 
Shuffle, Spot, Slip et Grid. Pour sélectionner 
le mode d’édition, cliquez sur le bouton 
correspondant dans la partie supérieure gauche 
de la fenêtre Edit.

Le mode d’édition a une incidence sur le 
déplacement et le positionnement des régions 
audio et MIDI (et des notes MIDI individuelles), 
sur le fonctionnement des commandes Copier 
et Coller, ainsi que sur le fonctionnement des 
différents outils d’édition (outil de trimming, 
sélecteur, main, crayon).

Outils d’édition

Pro Tools LE offre sept outils d’édition : Zoom, 
outil de trimming, sélecteur, main, outil de 
scrubbing, crayon et outil Smart. Sélectionnez 
l’outil de votre choix en cliquant dessus dans la 
fenêtre Edit. Le zoom, l’outil de trimming, la 
main et le crayon comportent des modes 
différents, qui peuvent être sélectionnés depuis 
un menu contextuel multiple lorsque vous 
cliquez sur l’outil.

Edition des régions

Les outils d’édition de Pro Tools LE permettent 
d’éditer les régions dans la fenêtre Edit. Une 
région est un élément de données audio ou 
MIDI auquel peuvent être associées des données 
d’automation. Il peut s’agir par exemple d’une 
boucle, d’un riff de guitare, d’un couplet d’une 
chanson, d’un effet sonore, d’une partie d’un 
dialogue ou d’un fichier audio dans sa totalité. 
Dans Pro Tools, les régions sont créées à partir 
de fichiers audio ou MIDI et peuvent être 
organisées en playlists de pistes audio et MIDI.

Boutons des modes d’édition

Vous pouvez également appuyer sur les 
touches F1 (Shuffle), F2 (Slip), F3 (Spot) et 
F4 (Grid) pour définir le mode d’édition.

Pour obtenir des informations détaillées sur 
les modes d’édition, reportez-vous au Guide 
de référence Pro Tools.

Outils d’édition de la fenêtre Edit

Appuyez sur la touche Echap pour basculer 
entre les différents outils d’édition.

Pour obtenir une description détaillée des 
outils d’édition, reportez-vous au Guide de 
référence Pro Tools.

Région audio

Zoom

Outil de trimming 

Sélecteur 

Main 

Outil de scrubbing

CrayonSmart
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Rognage de régions

Après avoir enregistré une piste audio, celle-ci 
contient une « région audio ». Si le début de la 
région comporte des silences ou que la fin de 
région inclut de l’audio supplémentaire, vous 
pouvez utiliser l’outil de trimming en mode Slip 
pour raccourcir le début ou la fin de la région.

Pour rogner une région audio :

1  Sélectionnez le mode Slip.

2  Sélectionnez l’outil de trimming.

3  Déplacez le curseur vers le début de la région 
audio (le curseur prend la forme d’un « [ »).

4  Cliquez sur le début de la région et déplacez le 
curseur vers la droite pour raccourcir la région.

5  Déplacez le curseur vers la fin de la région 
audio (le curseur prend la forme d’un « ] »).

6  Cliquez sur la fin de la région et déplacez le 
curseur vers la gauche pour raccourcir la région.

Vous pouvez également étendre une région en 
utilisant l’outil de trimming si les données audio 
se trouvent en dehors des limites actuelles de la 
région. Si vous souhaitez étendre le début de la 
région, faites glisser le curseur vers la gauche ; 
si vous souhaitez étendre la fin, faites-le glisser 
vers la droite.

Organisation des régions

Il existe plusieurs façons d’éditer et d’organiser 
des régions. L’exemple ci-dessous illustre la 
procédure de création et d’organisation d’une 
boucle de batterie pour composer une piste 
rythmique.

Pour créer et organiser une séquence rythmique :

1  Ouvrez ou créez une session dans 
Pro Tools LE. 

2  Spécifiez la mesure de session (MIDI > Change 
Meter) et le tempo (MIDI > Change Tempo).

3  Sélectionnez le mode Grid (Grille).

4  Préparez l’enregistrement en vous servant 
d’un clic MIDI (reportez-vous à la section 
« Utilisation du clic (métronome) », page 46). 

5  Enregistrez une piste de batterie (reportez-
vous à la section « Enregistrement d’une piste 
audio », page 56) en gardant à l’esprit que vous 
souhaitez n’utiliser que la meilleure mesure 
(votre enregistrement doit pouvoir rentrer dans 
la grille avec le tempo et la mesure spécifiés)

– ou –

Région audio sur une piste

Rognage du début d’une région

Rognage de la fin d’une région

Région « rognée »
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Importez un fichier audio, tel qu’une boucle de 
batterie d’une bibliothèque d’échantillons, et 
placez-le dans une piste audio (reportez-vous à 
la section « Importation de données audio », 
page 54).

6  Faites glisser la forme d’onde avec le sélecteur 
afin de sélectionner une mesure. La sélection 
s’aligne sur la grille spécifiée.

7  Créez une piste audio (File > New Track).

8  Dans le menu contextuel de l’outil Main, 
sélectionnez l’outil de séparation.

9  A l’aide de l’outil de séparation, faites glisser la 
sélection au début de la nouvelle piste audio. 
Une région est créée et apparaît au début de la 
nouvelle piste.

10  Tout en sélectionnant la région, choisissez 
Edit > Repeat.

11  Dans la boîte de dialogue Repeat, saisissez un 
nombre de répétitions, puis cliquez sur OK.

Vous obtenez alors une nouvelle piste 
rythmique avec une phrase « en boucle » 
(répétée). Vous pouvez utiliser ces outils 
d’édition pour effectuer des opérations d’édition 
encore plus avancées sur les régions. 
Par exemple, vous pouvez séparer des temps ou 
« sons » en régions individuelles et les 
réorganiser en mode Grid ou Shuffle, et créer 
ainsi des rythmes originaux.

Playlists et édition non destructive

Les playlists permettent de créer et d’extraire 
plusieurs versions du contenu des pistes. Elles 
peuvent comprendre des prises complètes, des 
enregistrements fractionnés ou des ensembles 
de sélections provenant de prises multiples. 
Vous pouvez dupliquer les playlists afin 
d’enregistrer des éditions dans leur état actuel, 
puis poursuivre l’ajout de modifications dans la 
nouvelle playlist, tout en sachant que vous 
pourrez toujours revenir à la version précédente. 

Pour créer des playlists multiples pour l’édition :

1  Commencez avec une piste sur laquelle vous 
souhaitez apporter différentes modifications.

2  Dans le menu contextuel du sélecteur de 
playlist, choisissez Duplicate.

3  Attribuez un nom à la playlist dupliquée et 
cliquez sur OK.

4  Effectuez vos premières modifications.

Sélection en mode Grid

Déplacement d’une sélection à l’aide de l’outil de 
séparation

Boîte de dialogue Repeat

Duplication d’une playlist
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5  Retournez à la playlist originale en la 
sélectionnant dans le menu contextuel du 
sélecteur de playlist.

6  Répétez les étapes 2 à 5 pour effectuer toute 
modification supplémentaire.

Vous pouvez ainsi essayer différents modes 
d’édition de piste et passer d’une playlist à 
l’autre afin de comparer le résultat obtenu. 

Mixage
L’environnement de mixage Pro Tools dispose 
de nombreuses commandes de voie standard 
servant au réglage du volume, du panoramique, 
de la mise en solo et de la coupure de son. Les 
commandes de mixage et d’entrée/sortie 
peuvent être affichées dans les fenêtres Mix et 
Edit.

Pour afficher la fenêtre Mix :

■ Sélectionnez Windows > Show Mix.

Utilisation des commandes de voies

Volume : permet d’augmenter ou de réduire le 
niveau de la piste en faisant glisser son fader de 
volume vers le haut ou vers le bas.

Panoramique : permet de régler un panoramique 
dans le mixage. Pour cela, déplacez le curseur 
vers la gauche ou la droite.

Solo : permet de lire une piste en solo (en 
coupant le son de toutes les autres pistes). Pour 
cela, cliquez sur le bouton Solo lui 
correspondant.

Mute : permet de couper le son d’une piste. Pour 
cela, cliquez sur le bouton de coupure de son lui 
correspondant.

Acheminement de base du signal

L’acheminement du signal s’effectue par 
affectation des entrées et des sorties de piste. 
Les entrées de piste audio peuvent provenir de 
toute entrée matérielle ou de tout chemin de 
bus. Une fois enregistrée, l’entrée d’une piste 
audio correspond à son fichier audio sur le 
disque. Les entrées auxiliaires peuvent 
correspondre à n’importe quelle entrée 
matérielle ou n’importe quel chemin de bus 
interne. Quel que soit le type de pistes audio, les 
sorties peuvent être acheminées vers n’importe 
quelle sortie matérielle ou n’importe quel 
chemin de bus interne.

L’association de ces fonctions d’acheminement 
de signal permet d’adapter virtuellement 
l’architecture de la console de mixage aux 
projets, notamment aux envois et aux retours 
dans le cadre du traitement et du prémixage des 
effets.

Prémixage de type envoi/retour, en 
vue d’un traitement par effets

Lors d’un prémixage pour l’utilisation d’une 
réverbération, d’un délai ou de tout traitement 
d’effets similaire, utilisez les envois et les entrées 
auxiliaires pour recréer le routage d’envoi et de 
retour d’effets classique. Vous pouvez alors 
« partager » un plug-in en temps réel (consultez 
la rubrique « Plug-In », page 64) entre toutes les 
pistes entrant dans le prémixage. La quantité 
d’effet (Wet/Dry) dans le mixage se dose à l’aide 
des faders de piste (niveau de son direct) et du 
fader d’entrée auxiliaire (niveau de retour 
d’effet, Wet).

Appuyez sur la touche Commande et sur le 
signe égal (=) pour basculer
de la fenêtre Edit à la fenêtre Mix et 
inversement.
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Création d’un envoi

Pro Tools LE offre cinq envois par piste audio. 
Un envoi peut être mono ou stéréo et acheminer 
une sortie ou un des 16 chemins de bus internes. 

Pour assigner un envoi à une piste :

1  Assurez-vous que l’option Sends View est 
activée dans la fenêtre Mix (Display > Mix 
Window Shows > Sends View). 

2  Cliquez sur le bouton Sends sur une piste 
audio et choisissez un chemin depuis le menu 
contextuel.

3  Réglage du niveau de sortie de l’envoi. Vous 
pouvez régler le niveau d’envoi sur zéro en 
cliquant sur le fader d’envoi tout en maintenant 
la touche Option enfoncée. 

Création d’un retour

Les entrées auxiliaires peuvent être créées afin 
de remplacer les canaux de retour pour les bus, 
et les entrées depuis les sources matérielles.

Pour créer un retour :

1  Choisissez File > New Track et spécifiez 1 
entrée auxiliaire mono ou stéréo, puis cliquez 
sur Create.

2  Cliquez sur le sélecteur d’entrée de l’entrée 
auxiliaire et réglez-le sur le chemin de bus que 
vous avez assigné aux envois sur les pistes de 
source.

3  Cliquez sur le sélecteur de sortie de l’entrée 
auxiliaire et choisissez le chemin de sortie.

Affectation d’un envoi à un chemin de bus stéréo

Activez ou désactivez l’option Sends Default 
To « –INF » dans les paramètres de 
fonctionnement par défaut, afin de 
configurer le niveau attribué par défaut à un 
nouvel envoi sur –∞ ou sur le gain unitaire 
(0 dB). 

Pistes d’entrées audio et auxiliaires configurées pour 
un envoi et un retour

Envoi

Entrée aux.

aux bus 9 et 10

depuis les bus 9 et 10

Fenêtre Send Plug-in temps réel
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Faders principaux

Les faders principaux sont utilisés en tant que 
sortie et bus généraux et peuvent contrôler toute 
sortie mono, stéréo ou multicanal ou le chemin 
de bus dans une session. Vous pouvez alors 
utiliser les commandes du fader principal pour 
contrôler le volume, la mise en solo et la 
coupure de son ou pour appliquer des inserts à 
ces chemins. 

Lorsque vous compilez votre mixage final, il est 
recommandé d’utiliser un plug-in Dither sur le 
fader principal qui gère vos sorties principales 
(reportez-vous à la section Guide de référence 
Pro Tools).

Pour créer un fader principal :

1  Choisissez File > New Track et spécifiez 1 piste 
de fader principal mono ou stéréo, puis cliquez 
sur Create.

2  Dans la fenêtre Mix, cliquez sur le sélecteur de 
sortie du fader principal et choisissez le chemin 
de sortie que vous souhaitez contrôler. Vous 
pouvez choisir des sorties ou des bus internes.

Pour utiliser un fader principal comme contrôle de 
volume stéréo principal pour toutes les pistes 
dans une session :

1  Choisissez File >New Track et spécifiez 1 piste 
de fader principal stéréo, puis cliquez sur Create.

2  Envoyez les sorties de toutes les pistes audio 
de la session vers les sorties 1 et 2, puis 
configurez le panoramique de chaque piste.

3  Réglez la sortie du fader principal sur votre 
chemin de sortie principale (sorties 1 et 2).

Plug-In 
Les plug-in fournissent des égaliseurs, des 
dynamiques, des délais et d’autres types de 
traitement par effets. Les plug-in fonctionnent 
en temps réel ou non. Les plug-in RTAS 
correspondent à des effets non destructifs, qui 
s’insèrent dans les pistes pour traiter l’audio en 
temps réel (tout comme un processeur matériel 
le ferait, pendant la lecture). Les plug-in 
AudioSuite, quant à eux, correspondent à des 
effets destructifs qui traitent et créent des 
fichiers audio sur le disque en mode hors temps 
réel. Les plug-in AudioSuite peuvent aussi 
s’utiliser de façon non destructive, c’est-à-dire 
sans modifier le fichier audio original non traité 
sur le disque.

Les plug-in en temps réel sont assignés aux 
pistes depuis l’affichage des inserts dans la 
fenêtre Mix ou Edit. Après avoir été assignés à 
une piste, les plug-in apparaissent dans 
l’affichage des inserts de la piste et peuvent être 
ouverts en cliquant sur le bouton d’insertion.

Fader principal contrôlant les sorties principales

Plug-in Dither appliqué au mixage final

Sortie assignée au contrôle
du mixage principal 
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Pour insérer un plug-in temps réel sur une piste :

1  Assurez-vous que l’affichage des inserts est 
ouverte dans la fenêtre Mix ou Edit.

2  Cliquez sur le sélecteur d’insert sur la piste, 
puis sélectionnez le plug-in que vous souhaitez 
utiliser.

Pro Tools est fourni avec un kit complet de plug-
in DigiRack et de nombreux plug-in 
supplémentaires sont disponibles auprès de 
Digidesign et de ses partenaires de 
développement. 

Automation du mixage
L’automation du mixage permet d’enregistrer 
ou d’automatiser les modifications effectuées 
dans une piste et dans le niveau d’envoi, la 
coupure de son, le panoramique et les 
paramètres de plug-in. Les pistes MIDI 
permettent uniquement d’automatiser le 
volume, le panoramique et la coupure de son.

Pour écrire l’automation :

1  Dans la fenêtre Automation Enable 
(Windows > Show Automation Enable), activez 
le type d’automation (volume, panoramique, 
coupure de son, niveau d’envoi, coupure 
d’envoi ou plug-in).

2  Sélectionnez un mode d’automation pour les 
pistes que vous souhaitez automatiser (mode 
Write, Touch ou Latch). 

3  Lancez la lecture et démarrez l’enregistrement 
de l’automation en réglant les faders et autres 
boutons en conséquence. Pro Tools LE 
enregistre toutes les modifications apportées 
aux paramètres activés.

Plug-in Compressor

Pour plus d’informations sur les plug-in, 
consultez le Guide des plug-in DigiRack, le 
Guide des plug-in Digidesign et le chapitre 
réservé aux plug-in dans le Guide de 
référence Pro Tools. 

Plug-inBouton d’insertion

Activation de l’automation (à gauche) et définition du 
mode d’automation pour une piste (à droite)
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Une fois enregistrée, l’automation peut être ré-
enregistrée ou affichée et modifiée 
graphiquement dans la fenêtre Edit. 

Mixage final
La commande Bounce to Disk permet d’écrire 
un mixage final sur le disque, de créer une 
boucle, de « figer » des effets ou d’enregistrer 
n’importe quel prémixage. Une fois que vous 
avez enregistré votre prémixage final, vous 
pouvez utiliser un autre programme pour graver 
le fichier créé sur un CD.

Le prémixage (bounce) d’une piste sur un disque 
contient les éléments suivants :

Pistes audibles : toutes les pistes audibles sont 
intégrées au prémixage. Les pistes coupées 
(Mute) n’apparaissent pas dans le prémixage. En 
cas d’écoute en mode Solo d’une piste ou d’une 
région, seuls les éléments ainsi écoutés en Solo 
apparaissent dans le prémixage.

Automation : toutes les données d’automation 
pour lesquelles la lecture est autorisée sont lues 
et prises en compte pour le prémixage. 

Inserts et envois : tous les inserts actifs, et 
notamment les plug-in temps réel et les inserts 
matériels, sont pris en compte pour le 
prémixage.

Durée de sélection ou de piste : si vous 
sélectionnez une partie d’une piste, la durée du 
prémixage correspond à celle de la sélection. 
En l’absence de sélection, la durée du prémixage 
continue jusqu’à la fin de la session.

Pour exécuter Bounce to Disk :

1  Choisissez File > Bounce to Disk.

2  Sélectionnez une sortie ou un chemin de bus 
mono ou stéréo en tant que source de 
prémixage. 

3  Sélectionnez le type de fichier (WAV par 
exemple), le format (mono ou stéréo), la 
résolution (16 bits par exemple) et la fréquence 
d’échantillonnage (44,1 kHz par exemple). 

• Pour créer un mixage final pouvant être écrit 
sur un CD audio, assurez-vous d’avoir 
sélectionné AIFF, stéréo entrelacé, 16 bits 
et 44,1 kHz. 

4  Cliquez sur Bounce.

Automation du volume d’une piste dans la fenêtre Edit

Pour plus d’informations sur l’utilisation de 
l’automation, consultez le Guide de 
référence Pro Tools.

Point d’inflexion d’automation pour le volume

Affichage de piste réglé sur Volume
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Utilisation de dithering pour le 
mixage final

Vous devez utiliser un plug-in de dithering 
lorsque vous utilisez la commande Bounce To 
Disk ou lors d’un mastering vers un 
périphérique externe. La commande Bounce to 
Disk ne procède pas à l’application automatique 
du dithering. Pour appliquer du dithering à un 
fichier de prémixage, il faut insérer l’un des 
plug-in de dithering de Digidesign ou tout autre 
plug-in de dithering sur la piste du fader 
principal affectée au chemin source du 
prémixage. Les faders principaux sont souvent 
préférables aux entrées auxiliaires, car les inserts 
de fader principal s’installent après le fader 
(ce qui convient davantage au dithering).

Pour plus d’informations sur l’utilisation 
du dithering, reportez-vous au Guide de 
référence Pro Tools.
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annexe a

Optimisation du système Windows

Plusieurs variables affectent les performances de 
Pro Tools lors de son installation sur Windows 
XP. Si vous avez suivi les instructions 
concernant la configuration Windows 
contenues dans le Chapitre 2, « Configuration 
Windows » et que vous ne parvenez toujours pas 
à configurer votre ordinateur, suivez les conseils 
apportés ci-dessous. 

Dépannage et paramètres 
avancés

Apparition d’un écran bleu au 
démarrage

Après avoir installé Pro Tools LE et QuickTime, 
l’ordinateur ne fonctionne pas et seul un écran 
bleu apparaît. Utilisez l’option Ajouter ou 
supprimer des programmes pour désinstaller 
Pro Tools LE et QuickTime et procédez à 
nouveau à leur installation en suivant les 
instructions figurant dans la section 
« Installation de Mbox et Pro Tools LE », 
page 11. 

Paramètres avancés

Les optimisations du système suivantes peuvent 
améliorer les performances de Pro Tools sur 
certains systèmes. Il est recommandé de ne 
recourir à ces optimisations que si cela est 
nécessaire, car elles peuvent désactiver ou 
compromettre certaines fonctionnalités des 
autres programmes installés sur votre système.

Désactivation des cartes réseau

Désactivez toutes les cartes réseau de votre 
système, à l’exception des cartes FireWire que 
vous pourriez être amené à utiliser pour 
connecter un disque externe à votre système.

Pour désactiver une carte réseau :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Gérer.

2  Dans Outils système, choisissez Gestionnaire 
de périphériques.

3  Dans la fenêtre du Gestionnaire de 
périphériques, cliquez deux fois sur Cartes 
réseau, puis deux fois sur la carte réseau que 
vous souhaitez désactiver.

4  Dans l’onglet Général, choisissez Ne pas 
utiliser ce périphérique (activer) dans le menu 
contextuel Utilisation du périphérique, puis 
cliquez sur OK.

5  Fermez la fenêtre Gestion de l’ordinateur.

Norton Ghost est vivement conseillé, étant 
donné qu’il enregistre votre système en état 
de travail et qu’il bascule facilement à cet 
état en cas de désactivation involontaire de 
n’importe quel élément indispensable à 
votre ordinateur. 
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Performances des applications

Pour ajuster les performances des applications :

1  Cliquez avec le bouton droit de la souris sur 
Poste de travail, puis sélectionnez Propriétés.

2  Cliquez sur l’onglet Avancé.

3  Dans la zone Performances, cliquez sur le 
bouton Paramètres.

4  Sélectionnez l’onglet Avancé.

5  Dans la section des performances des 
applications, sélectionnez l’option Ajuster afin 
d’obtenir la meilleure performance.

6  Dans Utilisation de la mémoire, sélectionnez 
Cache système.

7  Cliquez deux fois sur OK. Vous devez 
redémarrer l’ordinateur pour que les 
modifications prennent effet.

Eléments lancés au démarrage

Moins les éléments en cours d’utilisation sur 
votre ordinateur sont nombreux, plus les 
ressources disponibles pour Pro Tools LE sont 
nombreuses. Certaines applications de 
démarrage consomment inutilement des 
ressources en processeur et devraient être 
désactivées. 

Procédez à la désactivation d’éléments de 
démarrage avec précaution, par exemple à celle 
des éléments suivants :

• Numéro de série d’un support portable requis 
pour les applications requérant une clé de 
protection contre la copie.

• Carte plug and play.

• Rapport des activités.

• Services cryptographiques.

• Client DHCP, TCP/IP Net BIOS et autres 
éléments liés au réseau, sauf si l’ordinateur 
n’est pas doté de connexion réseau ou 
Internet. Dans ce cas, ces éléments peuvent 
être désactivés.

Pour désactiver les éléments de démarrage du 
système :

1  Dans le menu Démarrer, choisissez Exécuter.

2  Tapez « msconfig » et cliquez sur OK : 
l’utilitaire de configuration du système s’ouvre.

3  Sous l’onglet Général, choisissez Démarrage 
sélectif.

4  Désactivez l’option Charger les éléments de 
démarrage, puis cliquez sur OK.

5  Cliquez sur Redémarrer pour redémarrer 
l’ordinateur.

6  Une fois le système redémarré, un message de 
configuration du système s’affiche. Utilisez 
Pro Tools pour constater que ses performances 
ont augmenté avant de cocher la case Ne plus 
afficher ce message. Si les performances ne sont 
pas plus satisfaisantes, exécutez la commande 
msconfig et sélectionnez le mode de Démarrage 
normal au lieu du mode de démarrage sélectif, 
ou désactivez les éléments lancés au démarrage 
et les processus non indispensables un par un. 

Norton Ghost est vivement conseillé, étant 
donné qu’il enregistre votre système en état 
de travail et qu’il bascule facilement à cet 
état en cas de désactivation involontaire de 
n’importe quel élément indispensable à 
votre ordinateur. 
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annexe b

Configuration d’AMS (Mac OS X 
uniquement)

Pro Tools LE 6.0 reconnaît les ports de votre 
interface MIDI comme ports génériques. Sous 
Mac OS X, utilisez l’utilitaire Audio MIDI Setup 
(AMS) d’Apple pour identifier les périphériques 
externes connectés à votre interface MIDI et 
configurez votre studio MIDI pour l’utiliser avec 
Pro Tools.

Pour configurer votre studio MIDI dans AMS :

1  Lancez Audio MIDI Setup (qui se trouve dans 
le répertoire Applications/Utilities)

– ou –

Dans Pro Tools, sélectionnez Setups > Edit MIDI 
Studio Setup.

2  Cliquez sur l’onglet MIDI Devices. 
AMS parcourt votre système à la recherche 
d’interfaces MIDI connectées. Si votre interface 
MIDI est correctement connectée, elle s’affiche 
dans la fenêtre avec chacun de ses ports 
numérotés.

3  Pour tous les périphériques MIDI connectés à 
l’interface MIDI, cliquez sur Add Device. Une 
icône représentant le périphérique externe avec 
l’image du clavier MIDI par défaut s’affiche.

4  Faites glisser l’icône du nouveau périphérique 
vers un emplacement approprié dans la fenêtre.

Audio MIDI Setup (onglet MIDI Devices)



Introduction à Mbox72

5  Connectez le périphérique MIDI à l’interface 
MIDI en cliquant sur la flèche correspondant au 
port de sortie de périphérique approprié et en 
faisant glisser la connexion (câble) vers la flèche 
d’entrée du port correspondant de l’interface 
MIDI.

6  Cliquez sur la flèche pour le port d’entrée de 
périphérique approprié et faites glisser le câble 
vers la flèche correspondant au port de sortie de 
l’interface MIDI. 

7  Répétez les étapes 3 à 6 pour chaque 
périphérique MIDI de votre configuration MIDI.

Pour configurer un périphérique MIDI externe :

1  Sélectionnez l’icône de périphérique externe 
et cliquez sur Show Info (ou cliquez deux fois sur 
l’icône correspondant au nouveau 
périphérique). 

2  Sélectionnez le fabricant et le modèle du 
nouveau périphérique dans les menus 
contextuels correspondants. Si le fabricant et le 
modèle de votre périphérique ne se trouvent pas 
dans les menus contextuels correspondants, 
vous pouvez saisir vous-même un nom.

Connexion des entrées et sorties MIDI

Pour supprimer une connexion, sélectionnez 
le câble et appuyez sur Delete. Pour 
supprimer toutes les connexions, cliquez sur 
Clear Cables.

Icône de périphérique externe

Attribution d’un nom à un nouveau périphérique MIDI
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3  Cliquez sur la flèche More Properties pour 
ouvrir la boîte de dialogue, puis activez les 
canaux MIDI appropriés (1 à 16) pour les 
options Transmits et Receives. Cette opération 
détermine les canaux qui seront utilisés pour 
envoyer et recevoir des données MIDI. 

4  Cliquez sur l’image du périphérique. 
La fenêtre s’agrandit et affiche des images 
correspondant aux divers périphériques MIDI 
(tels que les claviers, les modules, les interfaces 
et les consoles de mixage). Sélectionnez une 
icône pour votre périphérique. 

5  Cliquez sur OK. 

Les noms de périphériques que vous saisissez 
peuvent ensuite être sélectionnés comme entrée 
ou sortie MIDI dans Pro Tools. 

En ce qui concerne les noms de fabricant et 
de modèle, AMS se rapporte à un ou 
plusieurs fichiers dont le nom se termine par 
« .middev » et qui se trouvent dans le 
répertoire Root/Library/Audio/MIDI 
Devices. Pro Tools installe les fichiers 
Legacy Devices.middev et Digidesign 
Devices.middev qui contiennent des 
informations sur de nombreux 
périphériques MIDI disponibles à la vente. 
Si les noms de fabricant et de modèle pour 
tout périphérique externe MIDI ne sont pas 
disponibles dans les menus contextuels 
AMS Manufacturer et Model, vous pouvez 
les ajouter en modifiant le fichier .middev à 
partir d’un éditeur de texte, tel que TextEdit. 

Activation de canaux MIDI

Sélection d’une icône de périphérique

Pour utiliser vos icônes personnalisées, vous 
pouvez placer des fichiers image TIFF dans 
le répertoire /Library/Audio/MIDI/Devices/
Generic/Images. Celles-ci peuvent ensuite 
être sélectionnées à partir de la fenêtre du 
périphérique AMS.
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annexe c

Configuration d’OMS (Mac OS 9 
uniquement)

Pro Tools  LE requiert Open Music System 
(OMS) sur Mac OS 9, qui est livré avec le CD 
d’installation de Pro Tools. 

OMS possède les fonctionnalités suivantes :

• Il enregistre les informations concernant les 
types de périphériques MIDI que vous utilisez, 
la façon dont ils sont connectés et les sons 
qu’ils utilisent.

• Il permet au matériel MIDI de communiquer 
avec les applications musicales.

• Il fournit des services de synchronisation et 
assure la communication entre les 
applications.

OMS enregistre une description de votre studio 
MIDI dans les documents Studio Setup, qui 
peuvent être modifiés à l’aide de l’application 
OMS Setup. Une fois OMS configuré, vos 
applications musicales savent quels 
périphériques MIDI vous utilisez en se référant 
au document Studio Setup en cours.

Les sections suivantes décrivent les procédures 
de base de l’installation et de la configuration 
d’OMS. Pour plus d’informations, reportez-vous 
au Guide d’OMS au format PDF installé sur 
Pro Tools.

Configuration d’un nouveau 
Studio Setup

Avant de configurer OMS, assurez-vous que les 
interfaces MIDI sont connectées à votre 
ordinateur et que tous les périphériques 
connectés à ses ports MIDI sont allumés.

Pour configurer un nouveau Studio Setup 
dans OMS :

1  Lancez l’application OMS Setup. Si OMS n’a 
pas encore été configuré, un message vous 
demande de configurer un nouveau Studio 
Setup. Cliquez sur OK.

2  OMS vous invite à sélectionner le port du 
modem ou de l’imprimante pour rechercher les 
pilotes OMS. Si vous utilisez une interface MIDI 
connectée sur un port USB, ne cochez aucune 
case correspondant à ces ports. Cliquez sur 
Search.
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OMS recherche et affiche tous les pilotes et 
interfaces OMS détectés. Si votre interface 
n’apparaît pas, cliquez sur Troubleshoot. Une 
fois votre interface détectée, vous serez invité à 
rechercher les instruments MIDI qui y sont 
connectés.

3  Cliquez sur OK pour rechercher les 
périphériques MIDI connectés à l’interface 
MIDI. Pour être détecté, un périphérique doit 
être allumé et ses deux ports MIDI doivent être 
connectés à l’interface MIDI.

OMS recherche et affiche tous les périphériques 
MIDI détectés. Il est possible que certains 
instruments anciens ou récents ne soient pas 
reconnus par les routines de détection 
automatique d’OMS. 

Les périphériques non reconnus par OMS 
s’affichent avec un point d’interrogation rouge 
et portent le même nom que l’interface ou le 
port auquel ils sont connectés. Ils peuvent être 
définis comme étant nécessaires dans 
l’application OMS Setup (reportez-vous à la 
section « Définition des périphériques MIDI 
dans OMS », page 76).

4  Cliquez sur OK pour enregistrer le document 
Studio Setup.

Définition des périphériques MIDI 
dans OMS

Pour définir un périphérique MIDI dans 
OMS Setup :

1  Cliquez deux fois sur l’icône du périphérique 
dans la fenêtre Studio Setup.

2  Dans les menus contextuels de la boîte de 
dialogue MIDI Device Info, sélectionnez le 
fabricant et le modèle du périphérique. Si le 
périphérique ne figure pas dans la liste, laissez le 
modèle sur « other », puis donnez-lui un nom.

Options de la boîte de dialogue OMS Driver Search

Boîte de dialogue OMS Driver Setup

Périphérique OMS non défini



Annexe C : Configuration d’OMS (Mac OS 9 uniquement) 77

3  Sélectionnez le canal de réception (Receive 
Channels) du périphérique. S’il est capable de 
recevoir plusieurs canaux, sélectionnez l’option 
Is Multitimbral.

4  Si vous envisagez d’effectuer des 
enregistrements dans Pro Tools, sélectionnez 
l’option Is Controller. Si le périphérique est 
destiné à être une source ou une destination de 
timecode MIDI, Beat Clock ou messages MIDI, 
sélectionnez les options appropriées.

5  Cliquez sur OK.

Désactivation de Serial DMA 
dans OMS

Pour que Pro Tools fonctionne de manière 
optimale, vous devez désélectionner l’option 
Use Apple Serial DMA Driver dans l’application 
OMS Setup. Si vous ne désactivez pas cette 
option, les fonctions MIDI et les fonctions de 
synchronisation de Pro Tools ne fonctionneront 
pas correctement.

Pour désactiver Serial DMA dans OMS :

1  Cliquez deux fois sur l’application OMS Setup.

2  Choisissez Edit > Preferences.

3  Désélectionnez l’option Use Apple Serial DMA 
Driver When Available et cliquez sur OK. 

4  Quittez OMS Setup.

Boîte de dialogue MIDI Device Info
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annexe d

Tableau de bord Digidesign (Mac OS 9 
uniquement)

Si vous possédez un Mac OS 9 et que vous 
prévoyez d’utiliser votre matériel Digidesign 
avec des applications compatibles avec le 
Gestionnaire audio d’Apple, vous devrez 
installer le tableau de bord Digidesign.

Pour installer le tableau de bord Digidesign :

■ Lancez le programme d’installation de 
Pro Tools LE et sélectionnez l’option Digidesign 
Control Panel (reportez-vous à la section 
« Installation du logiciel Pro Tools LE », 
page 21).

Pour configurer le tableau de bord Digidesign :

1  Dans le menu Pomme, choisissez Tableaux de 
bord > Digidesign.

2  Dans le tableau de bord Digidesign, cliquez sur 
le bouton Setup Hardware.

3  Configurez la boîte de dialogue en fonction de 
vos besoins.

Pour utiliser votre matériel Digidesign avec le 
tableau de bord Son Apple :

1  Dans le menu Pomme, sélectionnez Tableaux 
de bord > Son.

2  Cliquez sur l’onglet Sortie.

3  Sélectionnez Digidesign, puis refermez le 
tableau de bord Son. 

Tableau de bord Digidesign

Tableau de bord Digidesign
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4  Si vous prévoyez d’utiliser une nouvelle fois 
Pro Tools, ramenez l’option Sortie sur Intégré 
avant de lancer l’application Pro Tools. 

Tableau de bord Son Apple

Lorsque vous utilisez le matériel Digidesign 
pour contrôler les applications Gestionnaire 
audio, allez dans l’onglet Alertes et réglez 
l’option Volume d’alerte sur zéro.
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